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1 About this User Manual

1.1 APEX3 Software for Chemical Crystallography

Figure 1.1 — APEX3 software (Integrate Images plug-in shown)

APEX3 is Bruker’s comprehensive software suite for single-crystal X-ray diffraction. APEX3, combined 
with Bruker’s X-ray diffractometer systems, provides the tools for complete small-molecule structure 
determination. The software provides the highest-quality data: from acquisition, collection, integration 
and scaling, through structure solution and refinement, and ending with publication-ready report 
generation.

APEX3 redefines user interaction with the crystallographic experiment. The interface guides the user 
through the complete experiment with minimal user input and maximal graphical feedback. APEX3 lets 
the user focus on the structure determination at hand and does not require any knowledge of 
instrument geometry or data collection strategies. The completely-automated structure determination 
plug-in XPRESSO makes APEX3 easy to use for the novice, but APEX3 has all of the features required 
by expert crystallographers.

The software features a client/server architecture that provides for remote control of—and access 
to—the instrumentation.

Additionally, the Integrate Debye Rings plug-in allows powder diffraction pattern integration and export 
to DIFFRAC.EVA.



About this User Manual APEX3 User Manual

1 - 2 DOC-M86-EXX229 V1

1.2 The Ylid Crystal

The compound used in the examples was 2-dimethylsulfuranylidene-1,3-indanedione (abbreviated 
“ylid”):

C11H10O2S

More information on the ylid crystal is available in the article “Polymorphism and History of 
2-Dimethylsufuranylidene-1,3-indanedione (YLID)”, Ilia A. Guzei, Galina A. Bikzhanova, Lara C. 
Spencer, Tatiana V. Timofeeva, Tiffany L. Kinnibrugh and Charles F. Campana. Cryst. Growth Des., 
2008, 8 (7), pp. 2411–2418, DOI: 10.1021/cg701260p.

Figure 1.2 — Ylid crystal structure

1.3 Terms and Conventions

1.3.1 Typographical Conventions

Table 1.1 shows typographical conventions used to help you quickly locate and identify information in 
this document.

Table 1.1 — Typographical conventions

Convention Usage

boldface
Software user interface controls (such as icons, menu items, and buttons) to be selected as part 
of the current procedure.

italics New terms and words requiring emphasis.

monospace Information read from or entered into a field or command prompt.

>
Navigation through a hierarchical menu. For example, “Choose Start > Programs > Bruker AXS 
> APEX3” describes navigating Windows’ menus from Start to Programs to Bruker AXS to 
APEX3.

[square brackets] Keyboard input.
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1.3.2 Equivalent Terms

1.3.2.1 Frame/Image

In 2-dimensional X-ray diffraction, the terms frame and image refer to the same 2-dimensional view of 
the diffraction pattern.

1.3.2.2 Greek and Roman Text

This document uses scientific terminology that may be rendered in Greek text. However, this document 
follows a convention of using Roman text to the greatest extent possible.

Table 1.2 — Greek and Roman Text

1.3.3 Notices: Danger, Caution, and Note

This document contains notices that must be observed to ensure personal safety, as well as to protect 
the product and connected equipment. These notices are highlighted as follows according to the level 
of danger.

WARNING! DANGER!
The word “DANGER” alerts you to an immediate 
or potential hazard that can result in death, 
severe personal injury, or substantial property 
damage.

WARNING! CAUTION!
The word “CAUTION” alerts you to a potential 
practice or condition that could result in minor 
personal injury or damage to the product or 
property.

NOTE: The word “NOTE” in bold capital letters 
draws your attention to particularly 
important information on the product or 
handling of the product, or to a 
particular part of the product 
documentation.

Greek Roman

θ theta

ω omega

φ phi

χ chi

κ kappa
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1.4 Referenced Documentation

The following Table contains a list of documentation referenced by this document. It is necessary to 
have this additional documentation available as you work with this document. In the documents’ part 
numbers, a variable revision number is given immediately after the part number. Always use the most 
current revisions available.

All of the documents shown may be found at Bruker’s comprehensive support site 
www.brukersupport.com, or on the Online Documentation CD-ROM that accompanies the shipment.

Table 1.3 — Referenced documentation

1.5 X-ray Safety

WARNING! DANGER!
X-ray equipment produces potentially harmful 
radiation and can be dangerous to anyone in the 
equipment’s vicinity unless safety precautions 
are completely understood and implemented. All 
persons designated to operate or perform 
maintenance on this instrument must be fully 
trained on the nature of radiation, X-ray 
generating equipment, and radiation safety. All 
users of the X-ray equipment may be required to 
accurately monitor their exposure to X-rays by 
proper use of X-ray dosimeters.

For safety issues related to operation and maintenance of your particular X-ray generator, 
diffractometer, and shield enclosure, please refer to the manufacturer’s operation manuals or to your 
Radiation Safety Officer. The user is responsible for compliance with local safety regulations.

Part Number Title

DOC-269-0175XX SAINT Software Reference Manual

DOC-M86-EXX024 Microscope Focus and Sample Alignment

DOC-M86-EXX184 D8 QUEST and D8 VENTURE Video Microscope Alignment Procedure

DOC-M88-EXX099 License Manager User Manual

DOC-M88-EXX190 DIFFRAC.SUITE Installation Guide
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1.6 License Considerations

You need a software license to activate your purchased software packages, options, and/or features.

Your Suite program (e.g., APEX3) requires a valid license file to operate. This file, “bn-license.dat”, 
must be present in the root directory of drive C:\ for the software to start properly.

If the license file is not present or has expired, an error window will appear when you try to start your 
Suite program. This window prompts you to run the License Manager application to obtain a valid 
license for the Suite.

For more information on licenses and License Manager, refer to DOC-M88-EXX099 License Manager 
User Manual.

Inquiries about licenses and Bruker licensing may be directed to licenses.BAXS@bruker.com.
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1.7 Help and Technical Support

1.7.1 The “What’s This?” Help Function

Context-based help is available at any time within the program by simply clicking the “What’s This?” 
help icon:

Figure 1.3 — “What’s This?” help icon

After clicking the icon, click on any window or field to obtain detailed help in a pop-up window.

The “What’s This?” help function can also be used at any time by pressing [Shift]+[F1].

1.7.2 Technical Support from Bruker Service Centers

You are invited to contact Bruker whenever there are problems or questions related to the system. 
Before you contact Bruker, please:

• Have the system’s serial number available;

• Determine the system’s software version (if you suspect a software problem);

• Record any error messages that appear; and

• Determine steps and conditions that recreate the problem (if possible).

WARNING! CAUTION!
Failure to refer instrument servicing to qualified 
Bruker personnel may result in injury or property 
damage!

1.7.2.1 Finding Your Local Bruker Service Center

A complete list of all Bruker Service Centers worldwide is available at:

http://www.bruker.com/about-us/offices/offices/bruker-axs.html

1.7.2.2 Brukersupport.com: Bruker’s Comprehensive Service Website

Registration with Bruker’s comprehensive support website, www.brukersupport.com, provides you with 
complete and up-to-date information for all of your owned equipment, including:

• All User Manuals, Procedures, FAQs, and other documentation;

• Software updates;

• Remote backup of your equipment settings and configurations; and

• Bruker official training and certification options.

When a new document or software update becomes available, you are immediately alerted via email.
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2 APEX3 Software Overview

From a software and operational viewpoint, the APEX3 software controls all operations—from crystal 
screening to report generation—for a typical crystallography study.

2.1 Server Programs

2.1.1 The Measurement Server

Bruker D8 QUEST and D8 VENTURE instruments are delivered with DIFFRAC.SUITE, a set of 
software applications used to create and start measurements, and perform other measurement-related 
tasks on the instrument.

Communication with the instrument takes place via a program called the Measurement Server, which is 

part of DIFFRAC.SUITE. The Measurement Server is started via a Desktop icon , and information 
about the Measurement Server is shown in the Windows Taskbar’s icons.

Figure 2.1 — Software relationships

Before working with APEX3, you must use Measurement Server to select the instrument you want to 
work with, establish a connection between it and the Measurement Server, and then enable the 
Measurement Server to get control of the instrument. This is done via the Measurement Server’s 
“Select Instruments” and “Status Window” windows.

Once the Measurement Server is connected to the instrument, you can start the BIS Server, which 
interprets commands sent by APEX3. Then, in APEX3, you can connect to BIS Server.

2.1.2 BIS Server or BIS

BIS Server is the software layer between the Suite program (e.g., APEX3) and the Measurement 
Server.

In the case of pre-DAVINCI.DESIGN (i.e., D8 Series I and II) instruments, BIS (also called “BIS 
Classic”) is all that is required; the Measurement Server is not used.
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2.2 Client Programs

2.2.1 APEX3 GUI and Plug-ins

APEX3 is the main program that controls experiments and analyzes data. The user works with APEX3 
through a variety of software modules, or plug-ins, for different aspects of an experiment. The Suite 
includes a Sample Database that stores relevant data from each step in the experiment.

2.2.2 Online and Offline Operation

The Suite can operate in online or offline mode.

In online mode:

• DAVINCI.DESIGN instruments use BIS Server to communicate with the instrument for 
performing experiments. To work in online mode, you must start Measurement Server, 
BIS Server, and your Suite program (i.e., APEX3).

• Pre-DAVINCI.DESIGN (i.e., D8 Series I or II) instruments use BIS Classic to 
communicate with the instrument. To work in online mode, you must start BIS. BIS 
Classic will also start VIDEO when needed.

In offline mode, the Suite program is not connected to the instrument, but is still able to analyze and 
interpret existing data (plug-ins requiring communication with the instrument will prompt you to 
connect). To work in offline mode, you only need to start your Suite program.
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2.2.3 APEX3Server

APEX3Server is operated on the computer that controls the instrument. It provides functionality for 
quickly centering a crystal and determining its diffraction quality.

APEX3Server contains two main plug-ins: “Center Crystal” and “Screen Crystal” (see Figure 2.2).

Figure 2.2 — APEX3Server’s “Screen Crystal” plug-in

2.3 The Sample Database

The Sample Database is used for the storage of data generated by the Suite. It is designed to 
transparently handle data from all of the Suite’s plug-ins without intervention from the user.

The Sample Database is used internally by the Suite and is not available for user customization or 
manipulation. It is automatically started when the computer starts up, and it is automatically stopped 
before the computer shuts down.
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2.4 The Main Window

The APEX3 graphical user interface (GUI) has one main window (Figure 2.3).

The main window is divided into five sections:

• Title Bar

• Menu Bar

• Tool Icon Bar

• Task Bar

• Task Display Area

Figure 2.3 — Main window diagram

NOTE: Throughout the interface, input fields 
with pink backgrounds indicate invalid 
entries. Disabled (i.e., grayed-out) 
fields indicate that a feature is not 
available (i.e., not supported or 
dependent upon the instrument 
configuration).
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2.4.1 The Title Bar

The Title Bar displays the software name and version, user name, sample, license type, and active 

plug-in. The right-hand edge of the Title Bar also contains the three Windows buttons  for 
minimizing, restoring, and closing the main window.

2.4.2 The Menu Bar

The Menu Bar provides drop-down menus for a variety of file operations, image tools, and help files.

An icon for the currently-active plug-in appears on the left-hand side of the Menu Bar. Clicking on this 
icon allows you to minimize, restore, resize, close, or move the currently-active window.

2.4.2.1 The Sample Menu

Figure 2.4 — Sample menu
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Table 2.1 — Sample menu commands

Sample menu command Description

Login...
Opens a window for logging into the Sample Database using your username 
and password.

Logout Logs out of the Sample Database.

Change Password... Opens a dialog for changing your Sample Database password.

New... Opens a dialog for creating a new sample in the Sample Database.

Open... Opens a previously-saved sample.

Reopen Reopens a recently-opened sample.

Save Saves the current sample.

Close... Closes the current sample.

Archive

Restore Archive... Restores an archived sample from a .zip file or CD/DVD.

Archive Sample... Archives the current sample to a .zip file or CD/DVD.

Delete Samples... Deletes samples from the Sample Database.

Show Notes... Opens the “Sample Notes” window.

Import
Allows you to import crystal information contained in a .p4p or .spin file into the 
Sample Database.

Export Allows you to export crystal data for the current sample as an .xml or .p4p file.

Run Command... Opens a command prompt window.

Exit Exits the application. This menu item has the same function as the  
button.
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2.4.2.2 The Instrument Menu

Figure 2.5 — Instrument menu

Table 2.2 — Instrument menu commands

2.4.2.3 The Windows Menu

Figure 2.6 — Windows menu

Table 2.3 — Windows menu command

2.4.2.4 The Help Menu

Figure 2.7 — Help menu

Table 2.4 — Help menu command

Instrument menu command Description

Connect... Opens a connection to BIS Server.

Disconnect If connected, disconnects from BIS Server.

Show Status...
Opens a window showing a summary of the current status of the instrument and the 
program’s connection to it.

Toggle Shutter
Instructs BIS Server to send a shutter open or close command to the instrument. If all 
interlocks and safety circuits are satisfied, the shutter will open and close.

Update Distance...
For manual detector tracks, allows you to update the detector distance if it disagrees with 
the value shown in the software.

Abort... Immediately aborts all pending instrument operations.

Windows menu command Description

Window selection
Displays a list of active windows. Any of these windows may be brought to the front by 
clicking its title.

Help menu command Description

About APEX3... Displays APEX3’s version and copyright information.

Acknowledgements... Displays third-party software contributions to APEX3.
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2.4.3 The Tool Icon Bar

Some icons on the Tool Icon Bar provide shortcuts to the options available through the Menu Bar.

Table 2.5 — Tool Icon Bar: menu bar shortcuts

Other icons on the Tool Icon Bar are visible only when a frame is displayed.

Table 2.6 — Tool Icon Bar: displayed frame controls

Icon Description

Creates a new entry in the Sample Database.

Opens an existing entry in the Sample Database.

Saves the current information to the Sample Database.

Shows the “Sample Notes” window

Stops any instrument activity.

“What’s this?” Context-sensitive help.

Icon Description

Shows the currently-displayed frame’s filename. Click the drop-down triangle to choose 
previously-displayed frames.

Opens a frame using a browse dialog.

Displays the first frame in a run.

Displays previous frame ([Alt + left arrow]).

Sequentially displays frames in reverse as a movie.

If displaying frames as a movie, stops the movie.

Sequentially displays frames as a movie.

Displays the next frame ([Alt + right arrow]).

Displays the last frame in a run.

Adjusts the rate of display when viewing frames as a movie.

Displays frames from the next lower-numbered run ([Alt + down arrow]).

Displays frames from the next higher-numbered run ([Alt + up arrow]).

Draws a plotting line. The plot appears below the image.

Draws a resolution circle.

Selects a region of the frame.
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2.4.4 The Task Bar

The Task Bar gives you access to all of the plug-ins available in the Suite.

NOTE: If the Task Bar is not visible, there is no 
open sample. Choose Sample > 
New... or Sample > Open... to open or 
create a new sample.

Table 2.7 — “Set Up” category

Table 2.8 — “Evaluate” category

Icon Name Description

Describe Sample Specify crystal size, color, shape, etc.

Center Crystal Crystal centering for manual (and, if applicable, motorized) goniometer heads.

Screen Crystal Provides tools for rapid crystal screening using phi and omega scans.

XPRESSO Automatic structure determination.

Icon Name Description

Determine Unit Cell Determine unit cell and Bravais lattice type.

Transform Unit Cell Transform a unit cell.

Compare Unit Cells
Compare unit cells to find twin laws.

View Reciprocal Lattice 3D visualization of the lattice projected in reciprocal space.

View Images View and analyze diffraction images.



APEX3 Software Overview APEX3 User Manual

2 - 10 DOC-M86-EXX229 V1

Table 2.9 — “Collect” category

Table 2.10 — “Reduce Data” category

Table 2.11 — “Examine Data” category

Icon Name Description

Calculate Strategy Calculation and customization of data collection strategies.

Run Experiment Sequence monitor and editor for data collection experiments.

Orient Crystal Measure diffraction images with the crystal aligned along specified axes.

Icon Name Description

Integrate Images Integrate diffraction data.

Index Crystal Faces Determine Miller indices and distances of single-crystal faces.

Scale Scale intensities and perform absorption correction.

Integrate Debye Rings Display and integrate single and multiple frames.

Unwarp and Convert Images Convert frames between formats.

Icon Name Description

Determine Space Group Dataset analysis and manipulation.

Analyze Data Run XPREP.

Synthesize Precession 
Images

Create precession images based on measured frames.

View Diffraction Space Create a 3D view in reciprocal space based on measured frames.

Find a Reflection Find a reflection in measured frames.
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Table 2.12 — “Find Structure” category

Table 2.13 — “Report” category

Icon Name Description

AUTOSTRUCTURE Automatic solution and refinement with minimum user input.

Solve Structure Structure Solution.

Refine Structure A graphical user interface for XL.

View Molecule 3D visualization of molecules.

Icon Name Description

Generate Report Use Bruker’s automatic report generation system.
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Right-click in the Task Bar to choose one of two views: Stack Bar or Tree View.

Figure 2.8 — Stack Bar view
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In Stack Bar view, click one of the Task Bar categories to display only the icons belonging to that 
category. All other Task Bar icons will be hidden.

Figure 2.9 — Tree view

In Tree View, categories may be expanded to display their Task Bar icons by clicking the plus or minus 
sign next to the category name.
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2.4.5 The Task Display Area

The Task Display Area (Figure 2.10) is the main area for tasks, user input, and graphical output (APEX3 
also produces files as output, such as *.hkl files).

This area displays images and other output from the plug-ins.

NOTE: In APEX3, Analyze Data (i.e., the user 
interface for XPREP) opens in a new 
window. All other plug-ins open in 
APEX3’s Task Display Area.

Figure 2.10 —Task Display Area showing the Data Collection Strategy plug-in
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3 Getting Started with APEX3

Before you begin using APEX3, it is necessary to start the program, log in, and create a sample in the 
Sample Database. All files (e.g., frames, *.p4p files, etc.) will be contained in a directory that you 
specify when you create the sample.

3.1 User Access

Bruker software allows different user accounts to have different levels of access to the instrument:

• Service

• Security

• Administrator

• User

• Non-user

User access is controlled via the User Manager program.

3.2 Start APEX3

Double-click the APEX3 icon on the Desktop (or choose Start > All Programs > Bruker AXS > APEX3 
if the license is properly installed).

APEX3’s main window opens.
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3.3 Log In

At the “Login” dialog, enter your user name and password (as shipped by Bruker, the default account is 
guest with password guest). Click OK.

Figure 3.1 — “Login” dialog

NOTE: If your setup does not require individual 
login accounts, you can configure the 
software to automatically log into a 
specified account by setting the 
shortcut’s target to e.g., 
“C:\bn\src\scripts\apex.bat 
user:guest password:guest”.

3.4 Connect to BIS Server (or BIS Classic)

NOTE: This step is optional; plug-ins will 
connect when needed.

1. To use the software in online mode, choose Instrument > Connect....

The “Instrument Connection” dialog appears.

2. Enter the name (or IP address) of the computer running BIS Server or BIS Classic (the 
dialog shows the default host; if these are running on the same computer as APEX3, 
the host name is localhost). Click Connect.

Figure 3.2 — “Instrument Connection” dialog
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3.5 Create a New Sample

1. Choose Sample > New....

The “New Sample” dialog opens.

Figure 3.3 — “New Sample” dialog

2. In the “New Sample” dialog, enter the sample name and choose an access group for 
your sample (if desired). The Suite will automatically create a directory for data storage.

NOTE: You can only use a sample name once 
per database. If the name is already 
taken, the program suggests an 
alternative sample name.

NOTE: The sample name and sample folder 
do not need to match. Even though the 
folder name is automatically filled in by 
the software, the user can redirect it to 
any folder on the computer (or 
network). Multiple projects can point to 
the same folder, which is useful for 
trying out multiple data-processing 
approaches. Be aware, though, that 
the same “\work” folder is used by all 
projects—it can be helpful to rename 
“\work” folders from previous analysis 
attempts.

3. Click OK.

The Task Bar appears with the “Set Up” category open.
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3.6 Describe the Sample with the Describe Sample Plug-in

1. In the Task Bar’s “Set Up” category, click the Describe Sample icon .

The Describe Sample plug-in opens.

2. Fill in the fields.

Figure 3.4 — Describe Sample plug-in (filled in)

Brackets can be used in the “Formula:” field to indicate multiple fragments (e.g., 
(C7H8)6. Also, simple abbreviations for organic fragments can be used (e.g., Me, Et, 
Pr, Bu, Cp, or Cp*.)

3. Close the Describe Sample plug-in by clicking the  button on the right-hand side of 
the Menu Bar.

The data is automatically saved to the Sample Database.
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3.7 Shutdown

3.7.1 Shut Down APEX3

1. Choose Sample > Exit.

2. In the “Closing Sample” window, choose whether to save or discard the changes made 
to the Sample Database.

Figure 3.5 — “Closing Sample” window

NOTE: The “Closing Sample” window appears 
even if no apparent changes were 
made to the Sample Database, 
because the date and time of the last 
access are held in the Sample 
Database and differ from the current 
date and time.

APEX3 closes.

3.7.2 Shut Down BIS Server

Click the  button in BIS Server’s upper right-hand corner.

BIS Server closes.

3.7.3 Stop the Measurement Server

On the computer controlling the instrument (i.e., the single computer or the Server in a dual-computer 

configuration), right-click the Measurement Server icon  in the Windows Task Bar. Choose Exit.

The Measurement Server stops.
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4 Crystal Centering and Screening

4.1 Centering the Crystal

To obtain accurate unit cell dimensions and collect high-quality data, it is necessary to position the 
crystal in the center of the X-ray beam and maintain this position for the entire experiment.

Your video microscope should be aligned so that the VIDEO software’s reticle coincides with the 
goniometer center. If the reticle does not coincide with the goniometer center, you can still center the 
crystal. A successfully-centered crystal stays in the same place in the microscope’s field of view in all 
orientations.

Also, the centering process can be greatly helped by lighting both the sample and background for 
maximum contrast.

NOTE: To make adjustments easier the 
goniometer head’s X, Y and Z locks 
may be loosened (with the thin end of 
the wrench—the other end of the 
wrench is used to move the adjustment 
sleds). Locking after centering needs 
only a very slight touch; do not 
overtighten the locks.

NOTE: Centering is often easier if the crystal is 
rotated to give a good view before the 
actual centering process is started 
(e.g., down an edge for a plate). To do 
this, drive to the initial centering 
position, loosen the crystal mounting 
screw (if present), rotate the crystal to a 
suitable orientation, and then tighten 
the screw again.

4.1.1 Start the Center Crystal Plug-in

Under the “Set Up” category in the Task Bar, click the Center Crystal icon  .

The Center Crystal plug-in opens.
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4.1.2 Mount the Goniometer Head

1. Open the enclosure door(s).

2. Carefully remove the goniometer head containing the sample from its case.

WARNING! CAUTION!
Use extreme care when handling the goniometer 
head to prevent damage to the sample.

NOTE: If you mount the sample yourself, make 
sure that the crystal is in an arbitrary 
orientation on the goniometer head 
(e.g., avoid mounting a needle-shaped 
crystal parallel to phi).

3. Place the goniometer head onto its base on the phi drive. Line up the appropriate slot 
on the bottom of the goniometer head with the pin on the mounting base (Figure 4.1).

NOTE: Modern goniometer heads have two 
slots, but only one fits the goniometer 
pin. The Z axis adjustment screw will 
face you in the default center position.

Figure 4.1 — Goniometer head bottom

4. Screw the goniometer head’s collar to the base so that the head does not move. Do not 
overtighten it (finger-tighten only).

Figure 4.2 — Huber goniometer head
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4.1.3 Center the Crystal on the Goniometer

NOTE: This procedure is applicable to both 
FIXED-CHI and KAPPA goniometers.

1. To show the video image, click the Start Grab button  .

NOTE: On pre-DAVINCI.DESIGN systems, 
the video will appear in a separate 
window.

2. Choose the desired reticle for centering by clicking the appropriate button (this 

example uses the crosshair reticle  .

3. Click the Center button.

The goniometer head drives so that its Y and Z translation axes are positioned 
perpendicular to the microscope.

Figure 4.3 — Center position, Y- and Z-axis adjustment screws

Figure 4.4 — Uncentered crystal as initially mounted
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4. Center the crystal in the video microscope reticle by making adjustments to the Y- and 
Z-axis adjustment screws.

Figure 4.5 — Centered crystal after Y- and Z-axis adjustments

5. Click Spin Phi 90.

Phi rotates so that the X-axis adjustment is facing the front of the diffractometer. Any 
error in the crystal’s position along the X axis will now appear in the microscope.

Figure 4.6 — Center position, X-axis adjustment screw

Figure 4.7 — X-axis error after spinning phi 90°
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6. Center the crystal in the video microscope reticle by making adjustments to the X-axis 
adjustment screw.

Figure 4.8 — Centered crystal after X-axis adjustments

7. Click Spin Phi 180 and check that, after rotating 180°, the crystal appears in the same 
position in the microscope reticle. If the crystal does not appear in the same position:

7.1. Use the adjustment screw facing you to remove half of the difference shown 
in the reticle (Figure 4.9 and Figure 4.10).

7.2. Click Spin Phi 180, and check that the crystal appears in the same position in 
the microscope reticle.

7.3. Repeat the preceding two steps until you are satisfied that the crystal remains 
in the same position in the microscope reticle when rotated by 180°.

Figure 4.9 — Example: error in Y axis

Figure 4.10 —Example: error removed by half
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8. Alternately click Spin Phi 90 and Spin Phi 180 to verify that the crystal stays in the 
same place in the microscope reticle through all motions of phi. If the crystal fails to 
stay in the same position as phi is rotated, make adjustments to the axes by repeatedly 
removing half the error (always using the adjustment screw facing you) as in step 7.

If the crystal does not remain centered, go back to step 3.

NOTE: It is important to note that, for 
non-spherical crystals of larger sizes, a 
perfectly centered crystal may still 
appear to move somewhat in the reticle 
if the microscope’s focal plane does not 
pass through the goniometer center.

NOTE: If the crystal consistently fails to appear 
in the same position when rotated by 
180°, the position of the microscope 
reticle may need adjustment. For more 
information, refer to 
DOC-M86-EXX024 Microscope Focus 
and Sample Alignment Procedure or 
DOC-M86-EXX184 D8 QUEST and D8 
VENTURE Video Microscope 
Alignment Procedure, as appropriate.

The crystal is now centered on the goniometer.
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4.1.3.1 Additional Verification Positions: Left, Right, and Top

In addition to the Center position, three other positions are available for verification of the microscope 
and crystal alignment: Left, Right, and Top.

These additional positions are typically only used for verifying that the microscope reticle is 
pointing at the goniometer center. If the crystal moves more than 10 microns (i.e., one-half reticle 
“tick”) between positions, the microscope may need alignment; see DOC-M86-EXX184 D8 QUEST and 
D8 VENTURE Video Microscope Alignment Procedure or DOC-M86-EXX024 Microscope Focus and 
Sample Alignment Procedure, as appropriate.

1. Click the Right button.

The goniometer drives to place the fiber horizontal and to the right.

NOTE: On a KAPPA goniometer, this position 
has an increased risk of ice formation if 
a low-temperature device is being 
used.

Figure 4.11 —Right position

Figure 4.12 —Crystal in right position



Crystal Centering and Screening APEX3 User Manual

4 - 8 DOC-M86-EXX229 V1

2. Click the Left button.

The goniometer drives to place the fiber horizontal and to the left. Note the height of the 
crystal in the video microscope reticle.

NOTE: On a KAPPA goniometer, this position 
has an increased risk of ice formation if 
a low-temperature device is being 
used.

Figure 4.13 —Left position

Figure 4.14 —Crystal in left position

3. Check that the crystal height is the same as the height you noted in step 2.

3.1. If the height is the same, you may be confident that the crystal is in the center 
of the instrument.

3.2. If the height is not in the same place, adjust to remove half of the difference, 
click Right, and repeat step 2 through step 3.
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4.2 Checking Crystal Quality

A number of tools provide information about the current image. These tools, present throughout the 
Suite, can help determine the diffraction characteristics of a crystal.

4.2.1 Start the Screen Crystal Plug-in

In the Task Bar’s “Set Up” category, click the Screen Crystal icon .

The Screen Crystal plug-in opens.

4.2.2 Set up the Scan

Figure 4.15 —Screen Crystal menu
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1. If you have a dual-source system, set the system to collect the scan at the desired 
wavelength.

2. Set the goniometer to the desired position either by using the preset position buttons, 
adjusting the sliders, or by manually editing the goniometer angle values.

NOTE: The User positions may be defined in 
the bn-config.py file.

3. Click Drive to initiate the requested movement.

NOTE: You must click the Drive button to 
move the goniometer to the new 
position. If the button is gray, the 
requested position violates the 
software limits.

4. Set up the scan parameters either by using the preset scan buttons or manually editing 
the values.

5. Choose whether to use the existing dark current correction or a new one by clicking the 
appropriate radio button (not applicable for shutterless data collection).

6. Click Drive + Scan to start the scan.

4.2.2.1 Collect a 360-degree Phi Scan

1. Click the 360° Phi button.

A value of 360.00 is displayed in both the “Scan Range:” and “Scan Width:” fields.

2. If necessary, enter an exposure time (the default exposure time is usually sufficient).

3. To start the scan, click the Drive+Scan button.
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4.2.2.2 Collect a Still Scan

1. Click the Still button.

A value of 0.00 is displayed in both the “Scan Range:” and “Scan Width:” fields.

2. Enter an exposure time.

You can select the units to be either seconds/frame or seconds/degree.

3. To start the scan, click the Drive+Scan button.

An example of starting goniometer positions for sample screening is shown in Table 
4.1. If the reflections are overlapping, increase the DX distance. If there are reflections 
that extend out to the edge of the image, increase the 2theta angle to determine how 
well the crystals diffract (10° intervals work well).

NOTE: If the low-temperature device’s nozzle 
is perpendicular to the goniometer 
base and chi is near zero for a long 
period of time, ice may form on the 
goniometer head. Whenever BIS 
Server becomes idle (and if the 
de-icing option is activated), it will 
automatically drive the crystal to chi = 
45° to eliminate icing.

Table 4.1 — Starting goniometer positions

4.2.2.3 Collect a Narrow or Wide Rotation Scan

1. Choose the desired rotation axis by clicking either the Phi or Omega radio button.

2. Choose either Narrow or Wide for the rotation angle.

The same values will appear in the editable “Scan Range:” and “Image Width:” fields.

For example, if you want to collect 3° of data at 0.5° intervals, choose Narrow and 
change 0.5 in the “Scan Range” field to 3.0. The “Image Width” field can also be 
adjusted in the same way.

3. Adjust the exposure time as you would for a still image.

4. Click the Drive + Scan button.

If the Correlate Exposures checkbox is activated, the image will be taken in two parts 
and added together (not available for shutterless data collection, and not 
recommended for PHOTON 100 detectors in any case). If the New dark image radio 
button is activated, the system will generate a new dark image with a duration equal to 
the current exposure time.

Goniometer DX (mm) 2theta (°) Omega (°) Phi (°) Chi (°)

FIXED-CHI 60 0 0 0 54.74 (fixed)

KAPPA 60 0 0 0 45
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4.2.3 Use the Resolution Circle Tool

1. Click the Resolution Circle tool  in the Tool Icon Bar to activate it.

2. Click and drag the mouse to draw the resolution circle.

The circle will extend outward from the beam center and display the resolution at the 
circle edge (the ring is always drawn from the direct beam position).

Figure 4.16 —Drawing a resolution circle

3. To hold the position, release the button.

4. To deactivate the Resolution Circle tool, click its icon in the Tool Icon Bar.
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4.2.4 Use the Line Tool

A quick way to check whether reflections are overlapping is to use the Line Tool.

A chart showing the counts for each peak under the line is displayed at the bottom. The length of the 
line in pixels and angstroms is also shown.

1. Click the Line tool  in the Tool Icon Bar to activate it.

2. To draw the line, click and drag the mouse.

When you release the button, the length of the line remains fixed and it can be placed 
anywhere on the image.

Figure 4.17 —Drawing a line

3. To deactivate the Line tool, click its icon in the Tool Icon Bar.
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4.2.5 Plot a Rocking Curve

The Box tool allows the rocking curve determination of a spot. The full-width half-maximum for a peak’s 
rocking curve is a good estimate of the peak’s mosaic spread. Looking at a few peaks away from the 
Lorentz region gives a rough idea of the overall mosaicity.

1. Click the Box tool  in the Tool Icon Bar to activate it.

2. Click and drag to draw the box.

If necessary, zoom into the selected area by right-clicking and choosing Zoom+.

3. Draw a box around a single reflection, right-click, and choose Rocking Curve.

A graph appears displaying the total counts as a function of the rotation angle.

You typically need around 1.5° of data on either side of a scan to sample several 
peaks. If the peak begins at and returns to the background level, the full-width 
half-maximum value will be displayed. If additional scans are available, the slider bar at 
the bottom of the graph allows the angular range to be increased.

Figure 4.18 —Rocking curve

4. To close the “Rocking Curve” window, click the  button.

5. To deactivate the Box tool, click its icon in the Tool Icon Bar.
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4.2.6 View Peak Profiles in 3D

1. Click the Box tool  in the Tool Icon Bar to activate it.

2. To draw the box, hold the left mouse button down and drag the mouse.

If necessary, zoom into the selected area by right-clicking and choosing Zoom+.

3. Draw a box around a peak or group of peaks, right-click, and choose 3D-View.

A 3D profile of the box region appears.

The profile can be rotated by holding down the left mouse button and dragging the 
mouse. the display colors can be changed by right-clicking the contrast scale.

Figure 4.19 —3D View

4. To close the “3D View” window, click the  button.

5. To deactivate the Box tool, click its icon in the Tool Icon Bar.
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4.2.7 Examples of Poor-Quality Crystals

Figure 4.20 shows a 360° phi scan on what might be a poor-quality crystal. The spot shape is poor, and 
the spots tend to run together. The obvious bands on the image suggest that the crystal is nearly 
aligned along an axis; however, spots will always apparently run together in a nearly-aligned crystal 
mounting. Figure 4.21 is much more convincing proof of a poor-quality crystal.

Figure 4.20 —Possible poor-quality crystal, 360° phi scan

Figure 4.21 shows a 2° phi scan on a poor-quality crystal. The spot shape is poor, and some spots 
seem split.

Figure 4.21 —Poor-quality crystal, 2° phi scan
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Figure 4.22 shows a 2° phi scan on a poor-quality crystal at +90 in phi. The spot shape is poor, and the 
spots are very close together.

Figure 4.22 —Poor-quality crystal, 2° phi scan, phi = +90°

Figure 4.23 shows a 360° phi scan on a small crystal. The diffraction power of the crystal is poor, but 
with longer exposure times this is a reasonable candidate for data collection.

Figure 4.23 —Good-quality crystal but weak diffractor
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5 Using the XPRESSO Plug-in

5.1 About XPRESSO

The XPRESSO plug-in is a fully-automatic structure collection and determination plug-in, operating 
entirely within APEX3.

The XPRESSO plug-in enables the instrument to automatically carry out all steps of the crystal 
structure analysis—through report generation—without further user intervention.

NOTE: The XPRESSO plug-in is designed to 
operate on Mo-target instruments with 
either fixed-chi or kappa goniometers. 
It should also function on Cu-target 
instruments, but may require more time 
to collect data.

5.2 Before Using XPRESSO

Before using the XPRESSO plug-in, it is necessary to:

1. Create a new sample in APEX3 (Section 3.5);

2. Describe the sample with the Describe plug-in (Section 3.6); and

3. Center the crystal on the goniometer (Section 4.1).

5.3 Start the XPRESSO Plug-in

In the Task Bar’s “Set Up” category, click the XPRESSO icon  .

The XPRESSO plug-in opens.

The XPRESSO plug-in’s main window contains three sections:

• An “information” section on the left that contains four tabs: “Images”, 
“Structure”, “Report”, and “Output”.

• A “parameters” section on the right that contains inputs for image data and 
the formula, in addition to unit cell information and a progress/score display.

• The Start and Stop buttons.
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5.3.1 Information Section

5.3.1.1 “Images” Tab

This tab contains the same image browsing and analysis tools as APEX3’s View Images plug-in. If 
XPRESSO is set to collect new images, the most recently-collected image appears under the “Images” 
tab.

Figure 5.1 — “Images” tab
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5.3.1.2 “Structure” Tab

During XPRESSO’s structure solution phase, this tab opens and displays the structure as it is solved 
and refined. As with other 3-D structure displays within APEX3, you are able to rotate, pan, and zoom 
using the mouse, as well as view Q peaks.

Figure 5.2 — “Structure” tab
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5.3.1.3 “Report” Tab

After XPRESSO has solved and refined the structure, this tab will display a report in HTML format.

Figure 5.3 — “Report” tab
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5.3.1.4 “Output” Tab

This tab continuously displays information about the data collection and solution process in a scrolling 
list.

Figure 5.4 — “Output” tab
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5.3.2 Parameters Section

5.3.2.1 “Image Data” Area

The “Image Data” area allows you to choose where XPRESSO will get its images: from data collection 
on an instrument, or from images that have already been collected.

Figure 5.5 — “Image Data” area

5.3.2.2 “Formula” Area

The sample’s chemical formula (entered in the Describe plug-in) appears in this field.

If you want to run XPRESSO again with a different formula, simply enter the new formula and click 
Start. However, you do not need to re-collect data—be sure to choose the Use existing images 
option.

Figure 5.6 — “Formula” area

5.3.2.3 Unit Cell Parameters

This window contains information about the unit cell found by XPRESSO. It continuously updates as 
better data is obtained.

When the process has been completed, the final unit cell parameters, mosaicity, space group, and R1 
values will be updated.

Figure 5.7 — Unit cell parameters
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5.3.2.4 Progress Display

As the analysis proceeds, each step in the process will be given a quality score (with 1.00 being 
perfect). In addition, the percent completion, elapsed time and remaining time will be updated.

When the process has been completed, the final scores for each step in the structure determination 
process will be updated.

Figure 5.8 — Progress display
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5.4 Set XPRESSO’s Options

5.4.1 Choose New or Existing Images

For normal operation, the XPRESSO plug-in will collect new images.

However, there is an option to execute the structure determination portion of the XPRESSO plug-in 
using existing images. This option may be used to view the crystal structure analysis steps, or to repeat 
the analysis with a different chemical formula.

1. In the “Image Data” area of the XPRESSO plug-in, choose either Collect new images 
or Use existing images.

NOTE: Regardless of the name of the specific 
sample, the acquired images from the 
XPRESSO plug-in are always named 
“matrix_0n_00xx.sfrm” (for preliminary 
unit cell determination images) and 
“scan_0n_0xxx.sfrm” (for data 
collection images).

2. If you chose Use existing images, Click the “Matrix runs:” and “Data runs:” browse 

buttons  to open “Select Runs” windows.

Figure 5.9 — Data runs selected in “Select Runs” window

5.4.2 Set or Change the Formula

If necessary, enter the desired formula in the “Formula:” field.

If you want to run XPRESSO again with a different formula, simply enter the new 
formula and click Start. However, you do not need to re-collect data—be sure to 
choose the Use existing images option.
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5.5 Start Data Collection and/or Structure Solution

Click Start to begin execution of the XPRESSO plug-in.

As the analysis proceeds, each step in the process will be given a quality score (with 
1.00 being perfect). In addition, the percent completion, elapsed time and remaining 
time will be updated.

Figure 5.10 —Progress display

When the process has been completed, the final scores for each step in the structure 
determination process will be updated.

5.5.1 XPRESSO’s Data Collection and/or Structure Solution Process

The XPRESSO plug-in is completely automated, from the time the Start button is clicked through report 
generation. User intervention is not permitted. A Stop button is provided for the user to completely 
terminate the execution of the XPRESSO plug-in.

Once Start has been clicked, XPRESSO will acquire a set of preliminary images (named 
“matrix_0n_00xx.sfrm”) using a standard set of conditions optimized for your instrument configuration. 
These images are then used to determine the preliminary unit cell parameters and orientation matrix, 
and to evaluate the crystal quality.

Based on these preliminary scans, the plug-in optimizes the data collection parameters, taking into 
account such factors as crystal diffracting power and mosaicity, and begins collecting the actual dataset 
images (named “scan_0n_0xxx.sfrm”). The plug-in also provides an initial estimate of the time required 
to collect the complete dataset (assuming triclinic symmetry). All datasets are collected to a resolution 
of 0.84 Å (IUCr specifications).

After the structure has been solved and refined, the XPRESSO plug-in will automatically generate a 
report in HTML format.

5.6 Close the XPRESSO Plug-in

Click the Close  button in the Menu Bar (not in the Title Bar).

The plug-in closes.
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5.7 Using XPRESSO in Conjunction with APEX3

You may use APEX3’s other plug-ins to display the structure, edit the report files, or renumber atoms.

You also have the option of repeating the entire analysis in a conventional, stepwise manner beginning 
with the data collection images (i.e., “scan_0n_0xxx.sfrm”). This option may be required if the 
XPRESSO plug-in fails to solve the structure due to an incorrect formula or twinning.
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6 Data Collection

In the data collection example that follows, we will use an ylid crystal with the sample name ylid 
(entered in Section 3.5).

6.1 Determining the Unit Cell

Unit cell determination is performed in several steps:

1. Data collection

2. Harvesting of reflections from collected frames

3. Indexing of harvested reflections

4. Bravais lattice type determination

5. Refinement

These steps are integrated in the Determine Unit Cell plug-in, which also contains a one-click solution 
for fully-automated unit cell determination.

The upper right-hand corner of the Determine Unit Cell plug-in contains two sections:

• Automatic Mode: for fully-automated unit cell determination (Section 6.1.2); and

• Manual Mode: for unit cell determination with user-defined parameters (Section 6.1.3).
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Figure 6.1 — Determine Unit Cell plug-in (initial view)

6.1.1 Start the Determine Unit Cell Plug-in

In the Task Bar’s “Evaluate” category, click the Determine Unit Cell icon  .

The Determine Unit Cell plug-in opens.
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6.1.2 Determine the Unit Cell in Automatic Mode

1. From the Start At: pull-down menu, select the step at which you want to begin 
automatic unit cell determination (useful if you want to find a unit cell from frames that 
have already been collected).

2. From the Stop After: pull-down menu, select the step at which you want to stop 
automatic unit cell determination.

3. Click Run.

Automatic data collection begins, and collected frames appear in the Information 
Display Area (you can abort the determination procedure at any time by clicking 
Abort.). The area containing the Automatic and Manual mode options changes to a list 
showing the system’s progress through the steps of unit cell determination.

Figure 6.2 — Automatic Mode progress list

When automatic unit cell determination is complete, the progress list will show a check 
mark and comments for each completed step (Figure 6.3).

Figure 6.3 — Automatic Mode progress list (complete)

4. Click the Close button to close the progress list and return to the main Determine Unit 
Cell window.

The window’s right-hand side displays the unit cell parameters, along with options to 
edit or delete the unit cell and reflection list if you wish to perform additional operations 
in Manual Mode.

If desired, you can set up your own runs for the Determine Unit Cell plug-in by using:

• For D8 Classic instruments: BCP’s Single Crystal function (in the 
“Instrument” category) or by editing the bn-config.py configuration file.

• For DAVINCI.DESIGN instruments: DIFFRAC.DETECTOR’s “Matrix Runs” 
section.



Data Collection APEX3 User Manual

6 - 4 DOC-M86-EXX229 V1

6.1.3 Manual Mode

The Determine Unit Cell plug-in’s Manual Mode functions allow you a great degree of control over unit 
cell determination. Manual Mode consists of five sections, each with its own menu, corresponding to 
the five stages of unit cell determination:

1. Collect Data

2. Harvest Spots

3. Index

4. Bravais

5. Refine

6.1.3.1 Collect Data

Figure 6.4 — Collect data menu
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Table 6.1 — Collect Data menu items

Menu Item Function

Image Location: Location where collected frames will be saved.

Image Base Name:
Text string that is appended to each frame’s filename and is used to identify frames by their 
filenames.

First Run:
Choose which run number will be the first run; useful for adding runs without overwriting 
previous ones.

Distance [mm]: Detector distance.

Exposure Time: Duration, in seconds, of each frame.

Image width [deg]: Distance, in degrees, that the scan axis travels over the course of a single exposure.

Detector Format: Resolution of the frames collected by the detector.

Correlate Frames:
Two frames are taken (each with half the duration of the overall Exposure Time), to correct for 
spurious events appearing on individual frames (not available in shutterless mode).

Anode: For dual-source systems, choose the wavelength for unit cell determination.

 [left arrow] Go to the previous step in the unit cell determination process.

 [right arrow] Go to the next step in the unit cell determination process.

Finish
Finish the sequence of steps in the unit cell determination process, beginning with the current 
step. Perform any tasks that are necessary.

Collect... Proceed with data collection according to the options set in the preceding menu items.

Cancel
Leave Manual Mode and return to the initial Unit Cell Determination page, performing no 
operations and ignoring any changes made to menu items.
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6.1.3.2 Harvest Spots

Figure 6.5 — Harvest Spots menu
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Table 6.2 — Harvest Spots menu items

Menu Item Function

First Image: Select the first image in the group of images to be examined for spots.

Number of Runs: Number of runs to be examined.

Images Per Run: Number of images to be examined in each run.

Go to Image:
Select a frame filename from this drop-down menu to display the frame in the Image 
Information Area.

Min. I/sigma(I):
Adjust the criterion for harvesting a spot based on its pixels’ intensity versus their standard 
deviation. Slide the slider between “More Spots” and “Fewer Spots” to vary the minimum 
I/sigma(I).

Smooth images
A Gaussian filter is applied to the frames prior to harvesting, which reduces the noise and 
eliminates falsely harvested pixels. For very weak data, however, the “Smooth images” 
function can interfere with successful harvesting.

Store (Reflection Group 
Combo Box):

The Reflection Group Combo Box shows a list of reflection groups to choose from. For each 
group, the group name and number of reflections in the group are displayed.
If, instead of the number of reflections, an entry is labeled empty, this indicates an unassigned 
entry. Choosing the empty entry creates a new group instead of appending to the current one.
A color is associated with each reflection group. The color is displayed in the box to the left of 
the group name. The color helps in recognizing a group while navigating through the software.

Save only reflections that 
span images

With this checkbox enabled, a spot is only harvested if it is found on multiple contiguous 
frames.

 [left arrow] Go to the previous step in the unit cell determination process.

 [right arrow] Go to the next step in the unit cell determination process.

Finish
Finish the sequence of steps in the unit cell determination process, beginning with the current 
step. Perform any tasks that are necessary.

Harvest Proceed with harvesting according to the options set in the preceding menu items.

Cancel
Leave Manual Mode and return to the initial Unit Cell Determination page, performing no 
operations and ignoring any changes made to menu items.
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6.1.3.3 Index

Figure 6.6 — Index menu
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6.1.3.4 Bravais

Figure 6.7 — Bravais menu

Table 6.3 — Bravais menu items

Menu Item Function

Bravais Lattice:

This list shows the 14 Bravais lattice types for the selected unit cell parameters. For each entry, 
the list contains (from left to right) the Bravais lattice type, the figure of merit (ranging from 0.0 
to 1.0, with 1.0 being perfect agreement), and the six unconstrained unit cell parameters for that 
Bravais lattice type.
Bravais lattices that are in agreement with the unit cell are displayed in green, while those that 
do not are displayed in red. The most likely Bravais lattice type is chosen automatically. If 
necessary, you may override the program’s decision by clicking on a different entry.
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6.1.3.5 Refine

Figure 6.8 — Refine menu

Table 6.4 — Refine menu items

Menu Item Function

Tolerance:
Upon startup, the Refine dialog determines a useful value for the tolerance. This may take a 
few seconds depending on the number of reflections.

RMS XY [mm], angle [°]:
The root mean square of the deviation between observed and predicted spot positions in the 
XY image plane and along the trajectory of the spot while it passed through the Ewald sphere.
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Histograms

Clicking Histograms... in the “Refine” step opens a window showing the reflections’ distribution of 
deviances from the calculated orientation matrix. The criteria include:

• H, K, and L;

• X and Y displacement in (mm); and

• Rotation angle in degrees.

Figure 6.9 — “Deviation Histograms” window

Additionally, the user can click on individual bars in the histogram to display the corresponding 
reflections in a list view.
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Orientation Matrix Transformations

Clicking Transformations... in the “Refine” step opens a window giving manual control over the 
orientation matrix.

A transformation matrix is created using the buttons at the top of the window (and the transformation 
matrix’s values can be manually edited by double-clicking the values). Clicking the Apply 
Transformation Matrix button results in a new unit cell, which is shown at the bottom.

This new unit cell may be committed by clicking OK, or discarded by clicking Cancel.

Figure 6.10 —“Orientation Matrix” window
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6.2 The Reciprocal Lattice Viewer Plug-in

The Reciprocal Lattice Viewer plug-in is a very powerful tool for viewing the harvested reflections in a 
reciprocal lattice.

6.2.1 Start the Reciprocal Lattice Viewer Plug-in

In the Task Bar’s “Evaluate” section, click the Reciprocal Lattice Viewer icon  .

The Reciprocal Lattice Viewer plug-in opens.

The plug-in automatically reads the reflections from the current project and displays 
them as a reciprocal space plot.

6.2.2 Views and Tools

Figure 6.11 is a typical unoriented view after opening the plug-in. Harvested reflections are shown 
based on their color slot (gray in this case). Black dots are weaker reflections that were filtered by the 
“Intensity Filter” slider at the bottom of the screen.

Figure 6.11 —Unoriented view
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Other tools can be accessed by right-clicking on the reflection viewer to give the “Quick Tools” menu 
(Figure 6.12), and by choosing RLATT in the Menu Bar (Figure 6.13).

Figure 6.12 —Quick Tools menu

Figure 6.13 —Full menu tools

Additional context-sensitive information is available by clicking the “What’s This” help arrow in the Menu 
Bar.

Figure 6.14 —“What’s This?” help icon
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6.2.2.1 Orienting Views

Left-click and drag the mouse to rotate the lattice display. It is possible to easily see rows and non-fitting 
peaks (see Figure 6.15).

Figure 6.15 —Display looking down layers of reflections
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By moving the intensity slider at the bottom of the display, it is easy to deselect weak reflections. In 
Figure 6.16, the reflections between the layer lines all turn black when the intensity filter is moved to the 
left.

Figure 6.16 —Display looking down layers of reflections. Weaker reflections, i.e., those with smaller I/sigma(I), are black because 
the “Intensity Filter” slider has been moved to the left.
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With additional rotations, the layers of reflections can be further oriented so that stacks of reflections 
become visible. Sometimes it is quite useful to right-click on the background and choose Z-rotations 
from the rotation options. The 2D profiles on the top and to the left are a valuable aid in this process. 
With practice, the 2D profiles can be organized into clusters. As shown, the 2D profiles are counting 
intensity. The counting mode can be changed to spot count or turned off completely using the 
Visualization menu (RLATT > Visualization) or by pressing the [s] key to cycle through the counting 
modes.

Figure 6.17 —An oriented lattice view. The 2D profiles are to the left and to the top.

The distance between layers can be measured by clicking on one of the clusters of lines in the 2D view 
and then dragging to the next cluster. If you drag over three clusters, then the distance as measured 
would need to be multiplied by three.

Figure 6.18 —Horizontal measured distance
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The Orientation menu allows easy orientation if the cell is indexed (Figure 6.19). Press the [F1], [F2], or 
[F3] key (these can be pressed at any time to orient the view) or click the appropriate button.

Figure 6.19 —Orientation menu
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6.2.2.2 Editing Options

The Edit menu is already shown in the right work area, when the plug-in is opened (Figure 6.20). You 
can also show it by selecting RLATT > Edit. It contains useful editing tools for selecting, sorting and 
deleting reflections.

Figure 6.20 —RLATT edit menu
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There are four different reflection selecting tools available, which work  in the reflection view area using 
the mouse control. You can either select reflections by drawing a Box, a Circle, or by clicking on 
individual reflections (Single Spot).

The most useful selecting tool is Lattice Overlay. When activated, you move the mouse pointer to the 
origin of the selection (normally a trusted reflection), left-click and hold the mouse button and finally 
drag the mouse pointer to another location. Normally you want to select reflection rows, so the 
perpendicular lines between the selected points should line up with the reflections. Once you release 
the mouse button, all reflections ending up on the perpendicular lines are selected (Figure 6.21).

You can hold the [Alt] key down while selecting your starting point (Linux users may find that the [Alt] 
key has operating system functions). This will lock to the centroid of the reflection on which the mouse 
pointer was placed.

If you want to start over, click on another spot and repeat the process.

Figure 6.21 —Two lattice lines selected
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You can press the [+] key to add lines between the two you have marked. Every time you press the [+] 
key, one additional line appears. The [-] key removes one line.

Figure 6.22 —View with most of the lattice lines selected (lines to the top and bottom are not selected).
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The [Page Up] key adds lines to the outside of the previously-selected line with the same line spacing. 
[Page Down] removes lines from the outside (Figure 6.23).

Figure 6.23 —A view with all the layers selected
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Click Invert Selection under “Selection Helpers”. Now, all the non-fitting spots that did not touch the 
layer lines are selected.

Figure 6.24 —Spots selected between layers

You can click Delete Selected (finalized at save) to mark the selected reflections to be deleted. First, 
they turn black and could be in principle selected again. They are finally removed from the reflection 
slot(s) if the Save button is clicked or the plug-in is closed.

Alternatively, these selected reflections can be added to a group by choosing a color with the “Current 
Group” combo box and clicking Add to Current Group.

You can hide the newly-assigned group by deactivating its checkbox in the “Select Visible Groups” 
section.
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6.2.2.3 The Unit Cell Tool

Enable the Unit Cell tool either by using the [u] key or by choosing RLATT > Unit Cell Tool and clicking 
the Unit Cell Tool button at the top, to put a unit cell lattice in the reflection viewer. This allows you to 
see if reflections are actually falling on the corners of the box (see Figure 6.25). Select Plane Size 
determines the boundaries of the planes and the number of unit cells displayed.

Figure 6.25 —Unit Cell tool enabled
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6.2.3 Measuring Distances and Angles

Right-click on the background, and choose Measure to get tools for measuring distances and angles 
(or select the Options from the RLATT menu).

The Measure Distance tool gives two lines, much like the lines in the Lattice Selection tool, that can be 
oriented and dragged to get lattice spacings (Figure 6.26).

Figure 6.26 —Measure distance tool

With the Measure Angle tool, left-click, hold, and drag a line on a lattice layer ending on the spot that 
will become the vertex of the angle. When the mouse is released, that point becomes the pivot point for 
a new line. Moving the mouse with no buttons depressed gives angle measurements (Figure 6.27). As 
described, the angle measurements will be done in 2D mode (i.e., the angle between the two lines 
displayed). To measure an angle in 3D mode, hold the [Alt] key while selecting spots as above. The tool 
will then lock on to spot centroids and the angle will be calculated using spot coordinates. This 
eliminates errors that might result from measuring using the 2D projection of the current orientation.

Figure 6.27 —Measure angle tool



Data Collection APEX3 User Manual

6 - 26 DOC-M86-EXX229 V1

6.2.4 Writing a .p4p File

At the bottom of the Edit menu, there is a button for exporting all visible reflections to a .p4p file. The 
.p4p file is a text file of crystal, instrument, and reflection information. If the cell and crystal orientation is 
known, that information is included also (otherwise, dummy values are included).

The sequence of cleaning up a set of reflections using the Reciprocal Lattice Viewer plug-in and then 
exporting the results for input to CELL_NOW is a useful tool for dealing with hard-to-index crystals.
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6.3 Calculate a Data Collection Strategy

APEX3 includes powerful algorithms for determining flexible, efficient data collection strategies for your 
instrument.

6.3.1 Start the Calculate Strategy Plug-in

In the Task Bar’s “Collect” category, click the Calculate Strategy icon  .

The Calculate Strategy plug-in opens.

6.3.2 Set Strategy Parameters Based on the Unit Cell

1. In the “Prepare” tab’s “Step 1” area (in the upper right-hand part of the screen), choose 
the desired unit cell from the drop-down menu.

2. In the case of dual-source systems, choose the desired anode with the Anode: 
drop-down menu.

3. Set the appropriate resolution limit for the desired strategy using the Resolution: field 
and menu.

NOTE: Check the default resolution (that is 
estimated by the Determine Unit Cell 
plug-in) before proceeding.
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4. Use the “Symmetry:” drop-down menu and Apply button to choose the symmetry.

Set the symmetry to treat Bijvoet pairs as equivalent (Centrosymmetric) or 
inequivalent (Chiral), or choose a specific point-group symmetry based on the metric 
symmetry of the unit cell.

A full sphere may be collected using a setting of 1.

NOTE: Although it is not necessary to click 
Apply if the symmetry was changed, it 
is very important to click Apply if the 
resolution limit was changed.

Figure 6.28 —Initial view with unit cell and symmetry chosen

5. If you have already measured a group of reflections for this sample and do not wish to 
do so again, activate the Already Measured: checkbox and use the Browse button to 
select a *.raw or *.hkl file specifying the reflections.

These reflections are removed from the unique reflections list, and a strategy to record 
missing reflections will be optimized.

NOTE: It is important to make sure that the 
*.raw or *.hkl file is consistently indexed 
to the unit cell chosen in step 1.
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6.3.3 Determine the Runs to be Collected

1. In the “Step 2” area, click the Determine Strategy... button.

The “Parameters for the strategy determination” window opens.

Figure 6.29 —“Parameters for the strategy determination” window
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2. Choose the strategy determination options:

2.1. Set the crystal-to-detector distance.

The strategy optimizer suggests the minimum possible detector distance that 
can still resolve the reflections (based on the unit cell and crystal mosaicity). 
Any distance greater than the suggested value should work. Please note that 
centered lattices are intentionally treated as primitive in case of a mis-assign-
ment or a supercell.

2.2. Choose the strategy type (phi and omega scans, or simply omega scans).

KAPPA goniometers also offer options for collecting Friedel pairs in the same 
frame (with omega scans for those that cannot be collected on the same 
frame) and for two 360° phi scans in reverse-beam geometry.

The shortest detector distance is suggested for which no reflection overlaps 
are expected based on the unit cell and crystal mosaicity.

2.3. For shutterless data collection, activate the Shutterless data collection 
optimization checkbox and set the shortest desired exposure time.

2.4. If you have a KAPPA goniometer and a low-temperature device, use the Use 
low temperature safe scan ranges checkbox to avoid chi angles that are 
prone to ice formation and to avoid centering problems due to thermal 
compression of the goniometer head.

2.5. Activate the Strict efficiency theta limitations checkbox to limit the swing of 
2theta to improve efficiency (this may limit the ability to acquire all data for 
triclinic settings).

This option can only be set when the full theta range is available and a suffi-
ciently large omega scan can be performed. Depending on the hardware con-
figuration, this is at a slightly further distance than the smallest DX.

This option limits the maximum 2 theta swing. The specified resolution will be 
found on either side of the detector, and therefore you will get the maximum 
redundancy. However, this may block some goniometer positions and the 
optimizer will automatically disable this option if it is impossible to achieve a 
sufficiently high completeness.

2.6. Set the desired completeness and multiplicity (i.e., redundancy).

The checkbox for minimum multiplicity includes the specified minimum multi-
plicity in the strategy calculation. By default, 90% of the data will have at least 
the specified multiplicity.

For a regular data collection optimization, a multiplicity of 1 is normally suffi-
cient. If you want to reduce the resulting redundancy, deactivate the check-
box; the optimizer then tries to give complete data with as few frames as 
possible.

3. Click OK.

The plug-in computes the data collection strategy.
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6.3.3.1 The Calculated Strategy Summary

After the calculation, a summary appears showing graphs of the calculated strategy along with a 
summary of the strategy’s runs.

The graphs on the left-hand side of the Task Display Area show relationships between completeness, 
resolution, multiplicity, and time, along with overall completeness and average multiplicity at the bottom.

Figure 6.30 —Strategy summary graphs
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The “Step 2” area of the plug-in shows a text summary of the runs including, for each run:

• overall sweep;

• number of reflections to be collected;

• number of unique reflections to be collected;

• (cumulative) multiplicity achieved;

• average multiplicity; and

• completeness.

Following this is a breakdown of the reflection distribution with respect to multiplicity. For example, 
multiplicity at 90% is the lowest multiplicity measured for 90% of the unique reflections.

At the end of the summary is the average multiplicity and the overall completeness (including missing 
reflections). If no exposure time is specified in step 3, this area shows the number of degrees scanned. 
If step 3 was done, you get the run time and the estimated completion time.

Figure 6.31 —Text summary
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6.3.3.2 Extending the Strategy

If desired, click Extend strategy... to specify collection of additional data based on multiplicity.

NOTE: Extending the strategy will increase 
data collection time. It is also 
necessary to increase the desired 
multiplicity above the already-achieved 
one; otherwise, the program will not 
add additional runs.

Figure 6.32 —“Strategy extension” window

If desired, click the “Edit” tab to manually change the calculated runs’ scan parameters.

The fields may be edited by double-clicking.

The sort option is an ideal tool for rearranging runs to achieve completeness as quickly as possible for 
a certain higher symmetry (e.g., if the strategy was calculated for a non-centrosymmetric point group, 
but there is a fair chance that the crystal symmetry is centrosymmetric).

Figure 6.33 —“Edit” tab
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6.3.3.3 Viewing the Strategy in Reciprocal Space

If desired, click Show reciprocal lattice view to display the strategy in reciprocal space.

Click a radio button in the “Show reflections” area to view unique reflections, all of the symmetric 
equivalents, or the missing reflections.

NOTE: If missing reflections and the black phi 
axis coincide, it is likely that the initial 
crystal orientation on the goniometer 
head is preventing a 100% complete 
data set (see Section 4.1.2).
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The sliders to the right adjust the visualization of the displayed reflections:

• The Multiplicity slider applies a lower-redundancy cutoff (left slider), or a 
higher-redundancy cutoff (right slider) to help visualize the data collection.

• The Sweep slider can be used to examine the data collection coverage with respect to 
experiment time.

• The Point size slider sets the size of the reflections in the visualization.

Additionally, checkboxes are available to activate and deactivate perspective view, reciprocal axes, the 
phi axis, and the HKL zero planes. Right-clicking in the window shows a menu with additional keyboard 
commands (e.g., alignment of the view along reciprocal axes).

Figure 6.34 —“3D strategy result viewer” window
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6.3.4 Set the Scan Parameters

1. At the bottom of the “Step 3” area, click the Select scan parameters... button.

The “Scan Parameters” window opens.

Figure 6.35 —“Scan Parameters” window

2. Set the scan parameters:

2.1. Set the desired scan width (i.e., frame angle) based on the crystal’s 
mosaicity.

The suggested frame angle is calculated to avoid overlaps in the rotation 
direction, based on the current cell parameters and the observed multiplicity. 
The Reset button repeats the calculation.

The strategy optimizer will suggest the widest possible scan width (the 
default range is between 0.3° and 2.0°, but this range can be edited via the 
bn-config.py file).

2.2. Set the scan time, in seconds per degree.

The initial suggested exposure time should be checked and eventually modi-
fied by the user.

The frame time is initially derived from the statistics of the intensity-ver-
sus-resolution table created during peak harvesting (this calculation is 
repeated when clicking the Reset button). Use this value as an indication 
only; the value may be derived from poor statistics, particularly when the 
table does not fully cover the intended data resolution.

2.3. Select or deselect shutterless scans (if supported by the detector).

2.4. If desired, click the Set Time... button to open a dialog that allows you to set 
the finish time (this adjusts the measuring time to best fill the time allowed).

3. Click OK.

The “Scan Parameters” window closes. Note that the elapsed time and expected end 
time have been added to the “Step 3” area.

The strategy calculation is now complete. The plug-in may be closed, and the runs may be used in the 
experiment by clicking the Append Strategy button in the Experiment plug-in.
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6.4 Run the Experiment

1. In the Task Bar’s “Collect” category, click the Run Experiment icon .

The Run Experiment plug-in opens, showing a table of operations to be performed.

2. If the list of operations contains orientation matrix runs, select and delete them by 
clicking (or [Shift] + clicking) the desired rows in the table and then right-clicking on the 
row numbers at the left and choosing Delete.

Figure 6.36 —Deleting matrix runs

3. Click Append Strategy.

The runs found by the Calculate Strategy plug-in appear in the list of operations.

The software changes the filename to the name of the current sample.

Figure 6.37 —List of operations with strategy appended
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4. To begin the experiment, click Execute.

The “Monitor Experiment” tab opens, and diffraction images begin to appear. This may 
take a minute or two if new dark current corrections are being collected, or if the 
generator is being ramped up from a low-power state.

NOTE: If resuming after a data collection 
interruption, the software will look for 
the first missing frame, and collect 
everything after that frame (even if it 
overwrites existing frames). The 
software will prompt you to overwrite 
any existing frames.

Figure 6.38 —“Monitor Experiment” tab
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6.4.1 User-Defined Runs and Settings

You can load and save your own experiments (in *.exp format) by using the Load Table... and Save 
Table... buttons at the bottom of the “Set Up Experiment” tab.

NOTE: Only allowed runs are imported when 
selecting a *.exp file. All runs that 
would lead to a collision are skipped 
without further notice.

Data collection controls are shown at the top of the “Set Up Experiment” tab. Usually, the default values 
are correct.

You can define the data collection mode of your detector with the Exposures option. Automatic will 
record uncorrelated (shuttered) images with PHOTON 100 or CCD detectors for exposure times shorter 
than 10 seconds. Correlated images are taken for longer exposure times on CCD cameras. 
Shutterless is only available for PHOTON II or supported PHOTON 100 detectors. For CCD or 
PHOTON 100 detectors, you can also force uncorrelated or correlated frames. Exposures of 3 or above 
correspond to multiple correlated images.

For data collection times of less than five seconds, correlation can usually be turned off. If new dark 
frames are required, BIS Server will automatically collect them. Activating the Generate new dark 
images checkbox forces the collection of a new dark frame for each exposure time used in the 
experiment (not before every run, though this can be specified in the bn=config.py file if necessary).

Retake if topped: The instrument will automatically use your instrument’s overflow protection routine 
(not available for shutterless detectors):

• For D8 Series II instruments, this involves a fast re-scan with ⅛ of the original exposure 
time (for correlated images; minimum 0.5 s) or 0.5 second (for uncorrelated images).

• For DAVINCI.DESIGN instruments, the attenuator is engaged.

Intensities of the saturated pixels will be scaled and replaced in the original frame.

Activating the Generate New Dark Images checkbox forces the collection of a new dark frame for each 
exposure time used in the experiment. This is only available for CCDs or PHOTON 100 detectors 
without shutterless mode.

Unwarp images: For detectors with spatial distortion (e.g., detectors using a demagnifying fiber-optic 
taper), the image can be stored fully corrected (i.e., “unwarped”).

If the experiment table shows “default” in the “Time” or “Width” column, the default exposure time or 
image width is used. You can set this option in the table by entering 0.

The de-icing feature will interrupt the data collection after the specified time and rotate phi by 180°. 
Afterwards, it continues automatically. Ice is normally blown off the sample holder by this routine. If you 
are using BIS Server, the system tries to keep your crystal ice-free even after the data collection is 
finished when the system is idle.

You can influence the naming of your run with the “Filename” field and the “First run” number (e.g., the 
first active data collection run can get run no. 3).

In Figure 6.37, the time and width are explicitly set for each run, so changing the default width and time 
will have no effect. If the explicit time or width for a run is deleted so that the box is empty, the word 
default appears and the default values at the top right will be used.
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The software tests the runs for illegal goniometer movements before the runs are executed. Therefore, 
it is not necessary to explicitly click Validate. However, it is useful if you are looking for the maximum 
allowed omega scan for a certain goniometer position without the risk of starting the data collection 
once you have found an allowed range.

If you click Validate and all movements are valid, the “All operations are valid” window will appear 
(Figure 6.39).

Figure 6.39 —“All operations are valid” window

6.4.2 Closing APEX3 or the Project

If desired, you can exit APEX3 after you begin data collection:

• In a single-computer setup, BIS Server and the Measurement Server must be left 
running (or, in the case of D8 Series II instruments, BIS Classic).

• In a dual-computer setup, the Server computer must be left on. If communications are 
lost between the Client and the Server, frames will be stored on the Server. Typically, 
they will be in the directory “C:\frames\”. They should be copied into the correct project 
directory before proceeding.

6.4.3 Abort the Experiment if Necessary

To abort the data collection, choose Instrument > Abort... or click the Stop button  in the Tool Icon 
Bar.

NOTE: You are not prompted to verify that you 
wish to abort the data collection.
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7 Data Integration and Scaling

Before the data can be used to solve and refine the crystal structure, it is necessary to convert the 
information recorded on the frames to a set of integrated and scaled intensities.

When setting up the integration, the Integrate Images plug-in creates a subdirectory named “\work” and 
assigns an output filename for each run’s integration results (“.raw” for single-crystal data, “.mul” for 
twins, and “.ram” for modulated samples—plus associated output files). These files are in ASCII form, 
which can be read by the Scale or Determine Space Group plug-in.

The SAINT Software Reference Manual DOC-269-0175XX provides a detailed description of the 
process of integration along with the various parameters involved, along with the SAINT file format.

It is possible to integrate while collecting data.

The Scale plug-in corrects for absorption effects in the data set and puts all of the measured data on the 
same scale. It uses data redundancy to achieve this, and tables and charts of diagnostics are 
presented throughout the process. Furthermore, Scale is able to correct for crystal volume variations, 
beam inhomogeneities, and crystal decay.
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7.1 Integrating Data

7.1.1 Start the Integrate Images Plug-in

In the Task Bar’s “Reduce Data” category, click the Integrate Images icon .

The Integrate Images plug-in opens (Figure 7.1), and the orientation matrix and Bravais 
information are loaded from the database.

Figure 7.1 — Integrate Images plug-in: initial view

7.1.2 Set the Resolution Limit

The “Resolution Limit (Å):” field (in the plug-ins upper right-hand corner) sets the upper (i.e., better) 
resolution limit to which the data will be integrated. The plug-in suggests a resolution limit, but this value 
can be edited.

Check the suggested resolution limit. If you want a limit other than that suggested, enter it in the field 
(the recommended minimum resolution is 0.83 Å).

Figure 7.2 — “Resolution Limit (Å):” field
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7.1.3 Select Runs for Integration

The plug-in’s right-hand side has two buttons for defining the data collection runs to be integrated: Find 
Runs... and Import Runs from Experiment.

Figure 7.3 — Find Runs... and Import Runs from Experiment buttons

The Find Runs... button is used to browse to the set of runs to be integrated. This button is normally 
used when the data collection is finished.

1. Click Find Runs....

The “Select Runs” window (Figure 7.4) opens.

2. Usually, the “Select Runs” window has the correct directory and base name as the 
defaults. If these are not correct, browse to the runs for the experiment of interest.

NOTE: To integrate images from a CD or DVD, 
browse to the device and find the runs 
to be integrated. The plug-in 
automatically writes the result in the 
“\work” directory for the current project.
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3. The window pane on the right-hand side displays all of the runs available in the current 
directory. Any combination of runs may be selected by simply activating the 
checkboxes next to the groups.

Figure 7.4 — “Select Runs” window

4. Click Choose.

The plug-in populates the list of runs to be integrated with the selected runs.

5. Alternatively, you can click Import Runs from Experiment.

The Import Runs from Experiment button determines the runs to be integrated from 
the experiment that has just been submitted. Using this button allows you to start 
integration while the data is still being collected.

NOTE: When integrating while collecting data, 
the Integrate Images plug-in will 
integrate all of the data currently 
measured and then wait for the next 
image, integrate that image, wait for 
the next, etc.

The plug-in populates the list of runs to be integrated with the runs from the 
experiment.
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7.1.3.1 Modifying Integration Run Lists

By editing the fields in the run list, the starting image name and output filename can be changed. You 
can use standard clipboard tools (e.g., Copy, Paste) by selecting a run entry and right-clicking on the 
entry number. In this way, it is also possible to count the number of frames available for each run.

Figure 7.5 shows a run list entry being modified. (A) shows the original run information. (B) shows the 
run with the starting image number changed to 51. (C) shows the number of frames to process changed 
to 363.

Double-click any of the fields in this list to open the value for editing.

Figure 7.5 — Example: manually editing a run list
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7.1.4 Refinement Options

Although the “Refinement Options” and “Integration Options” windows’ default values are generally 
very good, it may be necessary to adjust the integration box size and other parameters.

1. Click the Refinement Options... button in the lower right-hand corner of the plug-in 
(Figure 7.6).

Figure 7.6 — Refinement and Integration Options buttons

2. If necessary, adjust the refinement options (Figure 7.7).

Figure 7.7 — “Refinement Options” window
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NOTE: To change the default values that 
appear in the “Refinement Options” 
window, create a text file C:\saint.ini. 
Copy the sections and parameters you 
want to change from 
C:\bn\src\interface\saint.ini into 
C:\saint.ini (do not change 
C:\bn\src\interface\saint.ini).

Table 7.1 — Refinement options

3. Click OK to close the window.

Option Usage

Per-image refinement

Enable Box Size Refinement

If this checkbox is activated, SAINT will attempt to refine the initial 
box size estimates (i.e., the size of the integration box) to optimize 
the angular range of the volume used to store the model spot profile 
and the profile of each reflection integrated.
It is sometimes necessary to set the integration box to compact 
values (in “Initial XYZ Box SIze”) in order to avoid reflection 
rejections (e.g., exceeding the frame queue) or too many twin 
overlaps.

Initial XYZ Box Size

The plug-in’s estimate of the spot size in degrees. The program tries 
to come up with a good starting value, but sometimes the box is too 
small. This value is refined at the beginning of integration, so it 
usually does not need to be changed unless instructed by the 
plug-in.

Periodic refinement Frequency (Images)

This parameter determines after how many frames the periodic least 
squares refinement will be carried out during the integration. This 
has no effect on the least squares refinement taking place 
throughout the initial passes prior to integration.
Consider reducing the default value for wide frames.
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7.1.5 Integration Options

1. Click Integration Options... on the plug-in’s right-hand side.

The “Integration Options” window opens (Figure 7.8).

Figure 7.8 — “Integration Options” window

2. Click the More Options button to expand the window (see Figure 7.9).

Figure 7.9 — “Integration Options” window (expanded)

3. Set the options as necessary for your data.
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Table 7.2 — Integration options

4. Click OK.

Option Usage

Model 
Profiles

Blend Profiles from 
All Detector Regions

During the integration, the model profile shape is 
determined separately for nine regions of the detector (see 
picture). Blending the model profiles results in less variation 
across the detector area, and may provide better statistics 
for regions where the reflections are very weak.

Intensity/Sigma 
Lower Limit for Model 
Profile Update:

Prior to and during integration, a model of the average 
reflection profile shape is determined and updated. This 
profile is used to get a better estimate for the true intensity 
of weak reflections.
This parameter sets an Intensity/Sigma cutoff which 
determines the reflections that will be used to update the 
model profile. All reflections with an Intensity/Sigma value 
lower than this threshold are ignored.
It may be necessary to lower this value for frames with only 
weak reflections (typically in conjunction with activating the 
Blend Profile option).

Active 
Mask

Fractional Lower 
Limit of Average 
Intensity:

(This option is useful for CCD cameras, but should not be used for PHOTON detectors.)
To compute an active pixel mask, the software has to determine which pixels are active. 
This decision is made by comparing the counts that were registered by each pixel with 
the average counts on the image. A pixel is defined as “active” if it contains more counts 
than the fraction of average intensity which is specified here.
A value of 0.5 normally works fine for Mo data. A lower value is normally better for Cu 
data (~ 0.35). The resulting mask (“_am_XX_XXXX.sfrm”) should be checked in the 
“/work” directory. If the value is set too high, it is possible to mask large areas of your 
detector unknowingly.
PHOTON instruments use computed occlusion mask files “_xa_XX_XXXX.sfrm”, which 
include the bad pixel and beamstop shadow information, as integration masks.

Algorithm

Use narrow frame 
algorithm

The wide-frame algorithm differs from the narrow-frame algorithm as follows:

• Spot sizes in Z are estimated based on partiality statistics accumulated for those 
spots which span frames.

• Orientation least squares uses both “fulls” and “partials”, with “fulls” given zero 
weight in Z.

• Reflection profiles are collapsed in Z for purposes of correlation with model 
profiles and LS profile fitting.

• Spots that collide in Z (i.e., spots at similar X and Y with overlapping intensity on a 
common frame) are recognized and excluded from output. Their Z centroids may 
occur on the same frame, or on different (and not necessarily adjacent) frames.

Integration of wide-frame twin and modulated-structure data are both supported 
although not recommended, since problems with spot overlap will tend to increase.
The wide-frame algorithm will usually give better results in cases where the frame width 
is substantially greater than the spot width. Acquisition of wide frames often degrades the 
signal-to-noise ratio, especially for weak reflections, and results in a higher number of 
overlapping spots. Narrow-frame data collection is therefore recommended, and will 
usually result in higher data quality.

Use wide frame 
algorithm

Image 
Queue

Active Image Queue 
Half-Width (images)

The number of frames in the in-memory frame queue will be 2N + 1, where N is the value 
entered here. The default is N = 7, corresponding to a 15-frame queue, which should be 
fine for most purposes. The accepted range of N is 2 - 32, producing queue sizes from 
5 to 65 frames.
It is recommended to reduce the number for wide frames.
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7.1.6 Start the Integration

Click the Start Integration... button on the lower right-hand side of the plug-in.

Integration begins, and the “Integration” tab opens showing the SaintChart images for 
monitoring the integration.

A .raw file (containing the unmerged raw intensities) is written for each run. If multiple 
runs are integrated, a merged intensity file is written as well. The filename of the 
merged file contains a “0m” for the run number.

At the end of the integration run, the plug-in carries out a global refinement of crystal 
and detector parameters, followed by a statistical analysis of the integrated data set. 
The results are reported in the text display at the bottom of the “Integration” tab.

7.1.6.1 Monitoring Integration Progress with SaintChart

SaintChart is a powerful tool for monitoring the progress of the integration process and for graphically 
presenting the results of the integration process (Figure 7.10).

To the right of the image area are a series of checkboxes that select the displays. Activate or deactivate 
the checkboxes to add or remove displays.

Change the text area by clicking and dragging on the line between the text and image areas. You can 
also expand the windows to fill the available image area by clicking Chart > Tile in the Menu Bar.

Figure 7.10 —SaintChart view

For a full description of SaintChart’s windows and functions, refer to Section 11.1.

Chart Files

After integration, the results are reported in the text display and a chart file (*.cht) is written to the work 
directory. You can save and open chart files using the commands under Chart in the Menu Bar.
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7.2 Scaling Data

The Scale plug-in’s underlying engine is either SADABS for single crystals or TWINABS for twinned 
samples. The only required inputs for the Scale plug-in are:

• the integration results from the Integrate Images plug-in; and

• the Laue group.

For a more detailed description of the plug-in’s parameters, refer to the SADABS documentation file 
located at “C:\bn\SXTL\help”.

7.2.1 Start the Scale Plug-in

In the Task Bar’s “Reduce Data” category, click the Scale icon .

The Scale plug-in opens.

7.2.2 Set Up the Scale Operation

Figure 7.11 shows the right-hand portion of the plug-in’s “Setup” tab.

Figure 7.11 —“Setup” tab
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1. Check that the defaults are correct.

Pay special attention to the Laue Group symmetry; it is only automatically chosen when 
the plug-in is opened for the first time. In contrast to the multi-scan (i.e., empirical) 
absorption correction, numerical absorption correction requires the Index Crystal Faces 
plug-in (Section 7.3).

2. If necessary, read in the runs to be scaled:

Click the “Input Folder:” field’s Browse button  . A window appears showing the 
reflection files available for scaling. If the files are not visible, select the correct folder. A 
single run can be selected by highlighting that run and clicking Open. All runs with the 
same base name can be chosen by highlighting any of the runs in that series and 
clicking Open. The runs with the selected base name appear in the “Input File(s)” area, 
and they can then be selected individually with checkboxes. Selecting a merged file 
(i.e., the one ending in “m” rather than a run number) will use all of the runs that were 
integrated during the same integration job. The program will assign filenames for the 
output files. To change these names, edit the “Output HKL File Name” field under the 
“Advanced Setup” tab.

3. Choose the preferred Laue group and point group.

4. If necessary, adjust Additional Spherical Absorption Correction (it is not necessary 
for a numerical absorption correction, but it can still be used).

It is possible to apply an additional absorption correction assuming a spherical crystal 

with given μr, where μ is the linear absorption coefficient (in mm-1) and r is the radius of 
the equivalent sphere (in mm). This correction is included because the 
theta-dependent part of the absorption cannot be modeled well by comparing 
equivalent reflections for the empirical absorption correction (because these invariably 
have the same 2theta values). The main effect of applying it will be to increase the 
equivalent isotropic displacement parameters in the resulting refinement.

NOTE: It is strongly recommended to set this 
parameter correctly for large, 
strongly-absorbing crystals. 
Otherwise, your data will be biased.

5. If necessary, set additional parameters under the “Advanced Setup” tab.

These include:

• Fast scan resolution cutoff

• Allow for crystal decomposition by B-value Refinement

• Lambda correction

6. Click Start.

The plug-in proceeds to the “Parameter Refinement” tab.
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7.2.3 Refine the Parameters

The “Parameter Refinement” tab shows the reflection statistics before refinement, under the 
“Reflections” tab (Figure 7.12).

Figure 7.12 —“Parameter Refinement” tab before refinement

1. If necessary, set the refinement parameters (the defaults work well in most cases).

Two parameters deserve particular attention:

• Restraint ESD for Scale Factors: Restrains the scale factors from shifting too 
much during refinement. Relaxing the restraints a bit may help in some cases 
(e.g., for heavy absorbers or crystals larger than the beam), but be careful not 
to over-fit the data.

• Absorption Type: Sets the order of spherical harmonics used for the 
absorption correction. Medium is fine for all data sets. If there are heavy 
atoms in the unit cell and the data redundancy is high, the Strong Absorber 
setting may help.
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2. Click Refine.

The plug-in proceeds to the “Refinements” tab.

Figure 7.13 shows a typical refinement result. The R-values should decrease quickly 
and converge to similar values. The Mean Weight should increase and converge. The 
mean weight gives feedback about the data quality or the correct Laue group 
assignment. Values below 0.7 are suspicious, and the data should be carefully 
checked.

Figure 7.13 —“Refinement Graphs” tab after refinement

3. If necessary, make changes to the refinement parameters and click Refine to refine the 
data set again.

4. When you are satisfied with the refinement, click Next.

The plug-in proceeds to the “Error Model” tab.
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7.2.4 Refine the Error Model

Initially, the graphs in the “Error Model” area show an initial error model based on the default values in 
the “Outlier Rejection” area.

1. If necessary, adjust the parameters in the “Outlier Rejection” area.

The table contains a “Fast Scan” column. Runs below 10° 2theta can be selected as 
“Fast Scans”. Fast scans are recorded for shutterless data collections to prevent 
missing strong reflections in the data set because of detector saturation in the main 
runs. The “Fast Scan” is only used to fill in missing reflections in the main data set.

2. Click Error Model.

Figure 7.14 shows typical Error Model results.

Figure 7.14 —Error Model results

3. Examine the error model for problems:

• R(int): Agreement factor of the reflection intensities of the individual runs 
compared to the mean intensities of symmetry-independent reflections based 
on the Laue/point group.

• Number of Reflections: The column height displays the total number of 
reflections per run. The darker part of the column represents the number of 
reflections below 2 I/sigma(I)./

• K: Scale factor for the standard uncertainties.
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4. If necessary, adjust the error model and click Error Model again.

For example, to reject fewer reflections, increase the “|I-<I>|/su ratio for rejection” 
parameter in the “Outlier Rejection” area.

NOTE: If the R-values in one run are 
significantly higher than the others, you 
can repeat the entire scaling 
calculation with that run omitted. 
Deactivate the checkbox next to the 
“bad” run, and click Repeat Parameter 
Refinement.

5. When you are satisfied with the error model, click Finish.

The plug-in proceeds to the “Diagnostics” tab.
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7.2.5 Examine the Diagnostic Plots

Diagnostic plots provide valuable insight into the quality of the data and possible problems with the 
data.

Click the tabs at the bottom of the plug-in to view the diagnostic data (some of these plots are reviews 
of plots that have already been displayed).

7.2.5.1 Scale Variations

The Scale Variations plot (Figure 7.15) shows the overall variation in Scale and R(int) for the individual 
frames. The Scale plot should be flat (for strongly-absorbing, irregularly-shaped crystals it will probably 
be sinusoidal), and the R(int) plot should not show large variations (more than 2%).

Figure 7.15 —Overall Scale and R(int) variations
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7.2.5.2 Spatial Distribution Plots

Spatial Distribution plots are generated for each data collection run. They indicate spots that were either 
stronger or weaker than expected with a deviation from the mean intensity larger than three standard 
uncertainties.

Typically, the points of disagreement are spread fairly evenly over the detector face (Figure 7.16).

Figure 7.16 —Spatial Distribution plots

If the points are clustered in a single area or if there are significantly more spots of one color than 
another, the data should be examined critically. Figure 7.17 is from a data set in which the reflections 
collected in a certain area are consistently weaker than expected (possibly because the beamstop is 
not centered in the direct beam, or because the “<name>_xa_<run>_<frame>.sfrm” files were not 
present during integration). This kind of problem may affect the final results.

Figure 7.17 —Spatial Distribution plot showing a problem area

7.2.6 Close the Scale Plug-in

Click the Close button  in the upper right-hand corner of the plug-in.

The final hkl is generated, and the plug-in closes.
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7.3 Face Indexing with the Index Crystal Faces Plug-in

In order to perform a numerical absorption correction in the Scale plug-in, the crystal faces must be 
indexed. This allows a very exact crystallographic description of the crystal’s shape.

Indexing the crystal faces is an optional step in the data processing, which can be skipped. 
Nevertheless, a numerical absorption correction may give better results compared to an empirical 
correction for strongly-absorbing materials.

Furthermore, the crystal video is an ideal tool for keeping track of the measured crystal size 
(automatically determined during the indexing process), color, and morphology.

Once you have a unit cell for your crystal (required), the Index Crystal Faces plug-in allows you to 
define faces directly over images of the crystal.

7.3.1 Starting the Index Crystal Faces Plug-in

From the Task Bar’s “Reduce Data” category, click the Index Crystal Faces icon  .

The Index Crystal Faces plug-in starts and shows the crystal image (Figure 7.18), if a 
crystal video was recorded previously. Otherwise, a pop-up window appears from 
which you can either record a crystal video (Acquire New...) or load an existing video 
from another directory (Figure 7.19).

Figure 7.18 —Index Crystal Faces plug-in: initial view

Figure 7.19 —“Video Source” window
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7.3.2 The Index Crystal Faces Plug-in Interface

The Face Indexing plug-in uses a dial at the bottom of the screen to step through the images of the 
crystal, and a tool called the T-tool to define faces. The Face List, shown on the right, displays the faces 
you have defined for the crystal and their distance from the instrument center.

Table 7.3 — Face indexing controls

Table 7.4 — Face list controls

Item Description

Show T-tool Show and hide the T-tool for a better view of the crystal faces.

Max. Miller index: The highest Miller index shown as face normals in the overlay.

Max. out-of-plane angle 
(deg):

When the T-tool snaps to a face normal, the plane you define may differ from the specified 
index by a maximum of this amount.

Show possible face normals The plug-in suggests face normals.

Snap to possible face 
normals

The T-tool snaps to the suggested face normals.

Dial (or mouse wheel)
Use the dial to rotate around 360° of phi. The right-click menu lets you rotate phi by 180° to 
define parallel faces.

Crystal face information
Shows the Miller indices of a given face, the face’s distance from the instrument center, and 
the out-of-plane angle.

Item Description

Unit Cell Displays the unit cell that the plug-in uses to display faces in the overlay.

H,K,L Miller indices of the normal to the specified face.

Distance (mm) The specified face’s distance to the center of the instrument.

Remove Invisible Faces Faces obscured by the body of the crystal are removed from the Face list.

Closed: Displays whether the faces you have defined encapsulate a closed volume.

Size (mm): Dimensions of the crystal, calculated according to the defined faces.
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7.3.2.1 Setting View Options

Depending on the color and reflectivity of the crystal and background, you may want to adjust the 
display colors or re-set the crystal center.

Right-click in the image display area, and choose Configure Overlay from the menu.

The “Overlay Configuration” window appears (Figure 7.20).

Figure 7.20 —“Overlay Configuration” window
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7.3.3 Specifying Crystal Faces

1. Use the dial control at the bottom of the screen (or use the mouse wheel) to rotate the 
crystal until one of the faces is parallel to the microscope axis as in Figure 7.21.

Note that, because Show T-Tool and Show possible face normals are activated, the 
plug-in suggests possible faces (whose indices are within the Max. Miller Index range) 
with dotted lines.

Figure 7.21 —Face parallel to microscope axis

2. Move the mouse cursor to the dotted line that is perpendicular to the face.

The mouse cursor snaps to the possible face normal. A line appears to show the 
possible face. This line defines a plane along the microscope axis, which should be 
parallel to the crystal face. Note that these are possible face normals, and there may 
not be a visible face at every line.

3. Use the mouse to move the line until it touches the crystal face (Figure 7.22).

4. Click to fix the face.

An entry appears in the Face List showing the Miller Indices of the crystal face, along 
with the face’s distance from the instrument center.

Figure 7.22 —Fixing the face
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5. Repeat the steps in this Section to specify all of the crystal’s visible faces.

If the plug-in does not suggest a face normal for a certain face, you can increase the 
value in the “Max. Miller index” field to show more suggested normals. As you define 
more faces, the plug-in will begin to display its geometric model of the crystal, 
superimposed over the video images (Figure 7.23).

Figure 7.23 —Some—but not all—faces defined

The geometric model should fit the real crystal dimensions (Figure 7.24).

If the overlay displaces while rotating the crystal view, either the crystal was not perfectly centered or 
the microscope center is incorrect (see Section 7.3.2.1).

Figure 7.24 —All faces defined
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7.3.4 Editing the Face List

Consider Figure 7.25. The face (1 3 -2) does not appear to define a face correctly. Removing this face 
will give a more accurate model of the crystal.

Figure 7.25 —Face (1 3 -2) is incorrect

1. In the Face List, select the HKL (1 3 -2).

Figure 7.26 —Face List right-click menu

2. Right-click and choose Remove.

NOTE: Alternatively, you can select Clear List 
to start over, or Add and Edit to define 
your own faces and see where they 
appear on the crystal.
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7.3.5 Scaling with Face Indices

1. When all faces are defined, the plug-in has accurate crystal dimensions (as shown in 
the bottom right-hand corner). At this point, you can exit the Face Indexing plug-in and 
proceed with scaling.

2. In the Scale plug-in, be sure to select Numerical Absorption Correction under the 
“Setup” tab.
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8 Examining Data

After integrating and scaling the data, the crystal’s space group is determined and optional simulated 
precession photographs are calculated to further evaluate the overall quality of the data. Five plug-ins 
are available for this:

• Determine Space Group (based on XPREP);

• Analyze Data (which opens the command-line version of XPREP);

• Synthesize Precession Images (for looking at undistorted slices of reciprocal space);

• View Diffraction Space (for creating a 3D view in the reciprocal space based on 
measured frames); and

• Find a Reflection (for finding a reflection in the acquired images).

8.1 Using the Determine Space Group Plug-in

8.1.1 Start the Determine Space Group Plug-in

In the Task Bar’s “Examine Data” category, click the Determine Space Group icon .

The plug-in opens with the “Setup” tab active.
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8.1.2 Set Up the Determination Parameters

1. In the plug-in’s “Setup” tab, check that the default-loaded files are correct (Figure 8.1).

NOTE: Typically the files to use for space 
group determination are the “\work” 
directory’s *m.p4p file (containing the 
final unit cell parameters from 
integration) and *m.hkl file (containing 
the corrected intensities). You can 
browse to choose other files if desired.

Figure 8.1 — “Setup” tab

2. Click Next.

The plug-in proceeds to the “Lattice Exceptions” tab.
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8.1.3 Examine the Lattice Exceptions

The plug-in evaluates the data and suggests a lattice type based on the mean intensities and the mean 
int/sigma.

The green bar is the lattice type recommended by the software. In general, the higher and wider a peak 
is, the more likely the lattice type (Figure 8.2).

The height and width of the bars on the lattice page are determined as follows: The height is 1.0 - 
(observed lattice exceptions, divided by the number of possible lattice exceptions). If there are no 
lattice exceptions, the height is 1.0. The more lattice exceptions there are, the closer the height is to 0.0

In general, there is a wide variation in the heights, with the “correct” answer and P (if it is different) 
having heights of 1.0, and the others having various smaller heights.

width = 1.0 - (strong lattice exceptions, divided by the number of observed exceptions)

For most cases, the numbers are virtually identical, which gives a width near 0. So, there is a small 
minimum width. If the value is 0, the width will be the maximum.

Figure 8.2 — “Lattice Exceptions” tab

1. If you know that your sample has a different lattice type than that suggested by the 
plug-in, you can choose it from the Select Lattice Type pull-down menu.

2. Click Next.

The plug-in proceeds to the “Space Group Determination” tab.
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8.1.4 Choose a Space Group

The plug-in determines the reduced unit cell based on the chosen lattice type.

Figure 8.3 — Space group determination

1. A list of possible Bravais lattices is shown based on the Rsym value (the agreement of 
tentatively symmetrically equivalent reflections). The unit cell metrics can support the 
selection of a certain Bravais type.

2. A list of possible systematic absences (extinctions) for the crystal system is shown. The 
number of violating reflections, the number of strong violations and the average 
intensity and I/sigma(I). The table may help to select a suggested space group, or even 
to select a space group that was not suggested.

3. Check the E-value statistics to determine if the space group is centrosymmetric or 
non-centrosymmetric.

The expected values for the mean IE*E-1I are calculated for a centrosymmetric and a 
non-centrosymmetric space group. The mean IE*E-1I for the observed data set is 
displayed in the text box.

The slider is used to show how the true mean IE*E-1I fits in with the calculated values 
for the mean IE*E-1I. If the value is closer to the calculated centrosymmetric value, 
then the space group is probably centrosymmetric. If the value is closer to the 
calculated non-centrosymmetric value, then the space group is probably 
non-centrosymmetric.
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4. At the bottom of the Task Display Area, examine the suggested space groups and 
choose a space group by clicking its radio button.

NOTE: To choose a space group other than 
the suggested ones, click the Choose 
a different space group: radio button. 
This opens a drop-down menu of all 
permissible space groups.

5. Click Next.

The plug-in proceeds to the “Statistics” tab.

8.1.5 Examine the Reflection Statistics

Figure 8.4 — “Statistics” tab

1. Adjust the statistics parameters if desired:

• The two pull-down menus and the checkbox at the top of the “Statistics” tab 
allow you to create and switch among subsets of the data, and to control 
merging of equivalent reflections.

• The “Change Resolution Limits (Å):” area allows you to adjust the range of 
resolutions for which statistics are displayed and also to cut the data or create 
a new subset of reflections.
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2. After you have adjusted the quantities in the fields, click Set New Limits (which creates 
a new data set with the specified resolution) or Set New Limits and Redo Statistics 
(which sets limits on the current data set and recreates the tables and graphs).

NOTE: It is possible to revert the selection with 
the Current dataset: drop-down 
menu.

3. Examine the data presented in the table of statistics (Figure 8.4) and in the “Graphs” 
tabs along the bottom of the screen:

• Is the completeness near 100%?

• Are the redundancies at various resolutions close to the desired values?

• Are Rint and Rsigma small and increasing smoothly from top to bottom 
(low-resolution to high-resolution data)?

• Are the Overall Weighted R(int), Overall Weighted R(sigma), and Lowest 
Resolution (Å) appropriate for your experiment?
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Figure 8.5 — Graphs 1

Figure 8.6 — Graphs 2

4. Click the Next button.

The plug-in proceeds to the “Unit Cell Contents” tab.



Examining Data APEX3 User Manual

8 - 8 DOC-M86-EXX229 V1

8.1.6 Check the Unit Cell Contents

The “Unit Cell Contents” tab displays the current formula from the plug-in’s “Setup” tab, a tentative Z 
value, the density, and the atomic volume.

Figure 8.7 — “Unit Cell Contents” tab

1. Check that the information is correct:

1.1. Check that Z seems reasonable for the space group, that the Rho value 
(density) is as expected (1.1 to 1.4 for organic molecules, higher for inorganic 
compounds).

1.2. Check that the Non-H atomic volume is around 16 to 20.

Significant variation from the expected values may indicate an incorrect molecular 
formula (perhaps caused by an unexpected solvent, or crystallographic symmetry 
within the molecule).

2. If necessary, update the formula or Z units by typing directly in the field(s) and clicking 
the appropriate buttons at the top of the plug-in.

3. Click Next.

The plug-in proceeds to the “Set Up Files” tab.
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8.1.7 Set Up the Output File

1. If you want to change the output file name, type the new name in the “Instruction File:” 
field.

2. If you do not want to create an .hkl file (or overwrite an existing one), deactivate the 
Create .hkl File checkbox (it is activated by default).

3. Click Write Instruction File.

The plug-in fills in the appropriate commands for the .ins file.

Figure 8.8 — “Set Up Files” tab (filled in)

4. Click Accept to write the .ins file.
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8.1.8 Examine Cell Information

Click the “Cell Information” tab to examine additional cell information.

NOTE: The transformation matrix could be 
particularly useful for twins when 
switching from an HKLF 4 file (that 
went through XPREP and was 
transformed to fulfill IUCr requirements 
of the space group) to an HKLF 5 file.

Figure 8.9 — “Cell Information” tab



APEX3 User Manual Examining Data

DOC-M86-EXX229 V1 8 - 11

8.1.9 Examine Diagnostics

Click the “Diagnostics” tab to examine additional diagnostic information.

Figure 8.10 —“Diagnostics” tab (“# Data Points” Section shown)

8.1.10 Exit the Space Groups and Statistics Plug-in

Click the Exit button in the plug-in’s lower right-hand corner.

The plug-in closes.
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8.2 Determining the Space Group with XPREP

1. Under the Task Bar’s “Examine Data” category, click the Analyze Data icon  .

The plug-in starts, and the “Select Files for XPrep” window opens.

2. Check that the two files in the “Select Files for XPrep” window are correct for your data 
set (Figure 8.11) and click OK.

Figure 8.11 —“Select Files for XPrep” window

NOTE: In this example, the integration process 
has created two files: 
YLIDMO_0m.p4p containing the final 
unit cell parameters from integration 
and YLIDMO_0m.hkl containing the 
corrected intensities. Typically, these 
are the files to use for determining 
space groups, but you can browse to 
choose other files.

NOTE: In addition to space group 
determination, many other features of 
XPREP can be accessed from the 
general menu. Resolution cutoff, 
reciprocal space plots, simulated 
powder patterns, and a test for 
merohedral twinning are very useful 
tools.

3. Follow the program flow. Default options are automatically suggested and shown in 
square brackets. Make manual adjustments where necessary.
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8.3 Creating Simulated Precession Images

The Synthesize Precession Images plug-in provides an undistorted view of layers of the reciprocal 
lattice. The plug-in generates simulated precession images by finding the appropriate pixels in a series 
of frames. You must specify the images to examine and the zones to calculate.

1. In the Task Bar’s “Examine Data” category, click the Synthesize Precession Images 

icon  .

The Synthesize Precession Images plug-in opens.

2. Select the runs for image synthesis by clicking the Browse button  beside the 
“Images from” field.

A “Select Runs” dialog opens.

3. Choose the sets of images that you want to use for the calculation by activating and 
deactivating the checkboxes. Click OK.

4. Check the default input values. Modify as needed (decimal values such as “0.5kl” are 
also allowed), and click Calculate.

Calculating more zones does not significantly increase the calculation time. Reducing 
the resolution may speed the calculations slightly. The thickness defines the range of 
pixels above and below the requested range. For example, if the 0kl zone is requested 
with a thickness of 0.1, then the simulation will use all pixels that have -0.1 < h < 0.1, 
and any value (including fractional values) for k and l.

A progress bar appears (Figure 8.12).

Figure 8.12 —Progress bar

After a short time (depending on the speed of the computer and the number of frames 
read), the simulated precession image will appear on the screen. The calculated 
frames are written to a “\precession” subdirectory in the sample’s folder.

5. Display other planes by clicking on the calculated images in the bottom right of the Task 
Display Area, or by browsing as usual with the View Images plug-in.
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6. Use the simulated patterns to check space group symmetry (Figure 8.13) and to find 
signs of twinning or incommensurate modulation (Figure 8.14).

Figure 8.13 —Example 0kl plane

Figure 8.14 —A plane from a rotationally-twinned crystal, showing the two lattices



DOC-M86-EXX229 V1 9 - 1

9 Structure Solution and Refinement

The .hkl file (output by the Determine Space Group plug-in or, alternatively, XPREP) is all that is 
required to begin the structure solution and refinement process. The various steps of solving and 
refining the structure are carried out using the plug-ins in the “Find Structure” category:

• AUTOSTRUCTURE

• Solve Structure

• Refine Structure

• View Structure



Structure Solution and Refinement APEX3 User Manual

9 - 2 DOC-M86-EXX229 V1

9.1 Structure Solution and Refinement with AUTOSTRUCTURE

Using XT, the AUTOSTRUCTURE plug-in will automatically calculate initial phases, determine the 
space group of the crystal, and make preliminary atom assignments. After this solution, it will assign 
hydrogen atoms and perform structure refinement with XL, incorporating anisotropic parameters for 
thermal motion. It prepares a CIF file and presents the final results graphically in the viewer.

The only file required by AUTOSTRUCTURE is a set of reflections indexed on the cell found with the 
Determine Unit Cell plug-in. Any remaining information is extracted from the program database. A 
proposed chemical formula should be present in the Describe plug-in.

9.1.1 Set Up AUTOSTRUCTURE

1. In the Task Bar’s “Find Structure” category, click the AUTOSTRUCTURE icon  .

The AUTOSTRUCTURE plug-in opens.

Figure 9.1 — AUTOSTRUCTURE (ready to start)

2. In the “Input” area, the “Reflection File” field is populated with the most recent .hkl file. If 

you want to use another .hkl file, click the Open File icon  .

If present, an instruction file will load with the .hkl file. If absent, all of the necessary 
parameters will be extracted from the database.The chemical formula and Z can be 
changed as necessary by clicking in the appropriate fields.
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9.1.2 Automatically Solving and Refining the Structure

1. Click Start.

The Stop button becomes enabled, and AUTOSTRUCTURE begins solving and 
refining the structure.

As structure solution proceeds, the “Output” area displays the results, including the 
space group, formula, Z, R1, and wR2.

NOTE: Clicking Stop will not stop the 
auto-solution immediately; the process 
will stop after the display’s next update.

When the auto-solution process is finished, the final model will appear in the 3D view.

Figure 9.2 — AUTOSTRUCTURE (completed refinement)

2. If desired, manipulate the molecule’s 3D model in the view:

• Left-click and drag the mouse to rotate the molecule;

• Middle-click and drag the mouse to “pan” the image;

• Right-click and drag to zoom in or out;

• Use the mouse wheel to change the label size.

3. If desired, right-click on any of the atoms to explore the environment around the atom.

Select buttons are available to facilitate exploration of the structure (Figure 9.3).
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Figure 9.3 — Structure view buttons

Additional changes to the structure may be completed in the Refine Structure plug-in.

4. To close the plug-in, click the Close button  in the upper right-hand corner.

Button Function Button Function

Take a screenshot Visualize as ball-and-stick

Toggle between 
orthographic and central 
perspective projection

Toggle ADPs

Complete the molecules Toggle bonds

Toggle Q-peak bonds Toggle atom labels

Hide hydrogen atoms Toggle unit cell

Toggle atoms Toggle H-bonds

Visualize as tubes Atom styles
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9.2 Solving the Structure with the Solve Structure Plug-in

1. In the Task Bar’s “Find Structure” category, click the Solve Structure icon .

The Solve Structure plug-in opens. It contains tabbed sections for viewing the 
instructions file, listing file, results file, and a 3D model of the structure.

The plug-in automatically reads in a previously-generated .hkl file and information from 
the corresponding .ins and .p4p files that may be found in the “/work” folder.

Figure 9.4 — Solve Structure plug-in: initial view

2. The chemical formula (from the .ins file, or alternatively from the Describe plug-in) and 
Z are displayed in the “Input” area and can be modified if necessary.

NOTE: It is not necessary to have a .p4p file to 
solve a structure.

NOTE: The Intrinsic Phasing method does not 
necessarily require either an .ins or a 
.p4p file. It can run with an .hkl file and 
the unit cell and Bravais type 
information in the database.

An HKL data summary is show n in the “Statistics” field at the bottom of the screen. 
This feedback may help you in choosing the correct structure solution method.
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3. Select one of the structure solution methods from the “Method” area.

There are four main methods to choose from (however, Patterson is not available in the 
absence of a heavy atom with Z < 11).

Intrinsic Phasing:

This is the default structure solution method. The underlying program is called XT.

It does not require an accurate chemical formula, as it only takes atom types into 
account for the final element assignment. The solution of the phase problem is not 
negatively affected by the formula (unlike Direct methods). The algorithm even 
automatically adds heavy atoms if these were missing in the formula.

As mentioned above, it is not necessary to create an .ins file in order to run the 
program. It only requires the unit cell information and the Laue symmetry to work, 
which is directly taken from the data base in the absence of an instruction file.

The space group information in the instruction file will be ignored by the program. The 
space group assignment within the Laue group limits is part of the structure solution 
process.

There are additional options, which may help to solve a structure successfully:

• Intrinsic Phasing 2 forces the program to look more thoroughly for possible 
space groups.

• If the structure does not solve in the given Laue symmetry, it is also possible 
to pick a different unit cell (see the “Determining the Unit Cell” Section) from 
the unit cell combo box.

Alternatively, it is possible to modify the Patterson symmetry in the drop down menu. All 
lower symmetrical Patterson classes are available so that the symmetry can be 
gradually lowered for the structure solution attempts.

A modified unit cell can be saved to the database via the Save Patterson Symmetry 
as Unit Cell button. This facilitates the re-integration of the data, which is strongly 
recommended in these cases.

• It is possible to limit the space group selection to chiral or 
non-centrosymmetric cases, if there is prior trustworthy knowledge about the 
compound via the “Chirality:” selection box.

Direct Methods:

Structure solution using the direct methods (TREF) algorithm of XS.

In addition to the standard settings (Direct 1), you can run more solution cycles (Direct 
2) or add more advanced options using Direct 3.

The chemical formula should be correct, because missing heavy atoms or extra heavy 
atoms for light atom structures normally lead to a failed structure solution.

Dual Space:

The program XM is used to solve the structure. It requires special settings in the ins 
file, which are automatically set by APEX3 based on the given chemical formula.

The number of solution attempts can be selected via Dual Space 1 (100 cycles), Dual 
Space 2 (200) or Dual Space 3 (infinite; the best solution is displayed after the Stop 
after Iteration button is clicked).
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Patterson:

Structure solution using the Patterson method (PATT)  of XS. This method identifies 
heavy atoms in the asymmetric unit. In combination with the “Expand” option (TEXP 
command), light atom positions are shown as residuals (Q peaks).

Patterson 2 provokes a more exhaustive search.

4. Click Solve Structure to start the structure solution calculations (the button changes to 
Stop After Iteration if you want to stop the structure solution early).

You can see output from the underlying programs in the “Output” tab at the bottom of 
the screen during the structure solution process.

When the solution is complete, the “Structure View” tab displays the result (for further 
details about the “Structure View” controls, see Section 9.3). Along the bottom, the 
“Summary” tab shows the output (depending on the method used).

If Intrinsic Phasing is used, the space group, R1, and the alpha value are shown. If the 
program found multiple possible space groups, the best solution is picked, and the 
others are available from the space group combo box in the “Summary” tab.

The intrinsic phasing solutions are called “<name>_a(/b/c/...).res”. An individual .hkl file 
is created for each .res, so that the refinement can be easily started on all solutions.

The selected solution is renamed to “<name>.res” for further processing.

Figure 9.5 — Solve Structure plug-in output

NOTE: Previous solutions’ .ins, .hkl, and .res 
files are automatically saved to a 
“History” folder in the “\work” directory, 
if the Solve Structure button is clicked 
again.
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9.3 Refining the Structure in the Solve Structure Plug-in

The Solve Structure plug-in’s “Refine” tab offers several options for refining the solved structure using 
XP, XL, or XShell. After refinement, an updated R1 value appears at the bottom in the “Summary” tab.

Simply verify that the “Base:” field contains the correct name for the project you wish to refine. Then, 
click one of the buttons at the bottom to begin refinement.

Figure 9.6 — “Refine” tab

Table 9.1 — “Refine” tab

Control Description

Input Base This is the base name of the project to use.

Buttons

Refresh Files Refresh the tabs using the absolute latest contents of all of the files.

Copy RES to INS Clicking this button copies the contents of the results file into the instructions file.

Save Files Save any changes that you have made to the files.

Refine with XL Refine the instruction file using XL.

Open in XP Edit the results file using XP.

Open in Olex2
This button appears if Olex2 is installed on the PC and the installation directory is 
mentioned in the Windows path variables.

Open in XShell Open the selected file in XShell.

Browse For Base Click on this button to select a file to retrieve the base from.

Base Name This is the base name of the project to use.
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9.4 Refining the Structure using the Refine Structure Plug-in

The Refine Structure plug-in provides a user-friendly graphical user interface for the crystal structure 
refinement program XL. It is based on the ShelXle engine, which combines state-of-the-art graphics 
with a sophisticated editor for the instruction file. This makes the plug-in appealing both to beginners, 
who value the intuitive operation of the plug-in, and experts who have all of XL’s advanced features at 
hand.

The Refine Structure plug-in only requires a reflection intensity file (.hkl) and a corresponding XL 
instruction (.ins) or results (.res) file.

9.4.1 The Refine Structure Plug-in’s User Interface

In the Task Bar’s “Find Structure” category, click the Refine Structure icon  .

The Refine Structure plug-in opens.

On opening the Refine Structure plug-in, all fields are populated with the most recent .res file. If you 

want to use another .hkl file, click the Open File icon .

The plug-in is divided into an interactive structure viewer (left), a text area (right), and tool bars (top; 
Figure 9.7).

Figure 9.7 — Initial view
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9.4.1.1 The Structure Viewer

The model in the structure viewer can be manipulated by using the mouse:

• Left-click and drag the mouse to rotate the molecule;

• Middle-click and drag the mouse to “pan” the image;

• Right-click and drag to zoom in or out;

• Use the mouse wheel to change the label size.

A left click on any atom selects the atom and the text cursor automatically goes (word?) to the 
corresponding line in the instruction editor on the right. Further details about the atom environment will 
be shown in the Information Window tab at the bottom right.

The distance between two atoms is shown in the Information window, if you consecutively click on two 
atoms. The angle between three or the torsion angle between four atoms are calculated once they are 
clicked in a row (Figure 9.8).

Figure 9.8 — Information window

The [Shift] key can be used to select multiple atoms at a time. Selecting one atom and then 
[Shift]+clicking on another atom selects all atoms between the two atom positions in the instruction file.

Right-clicking on an atom opens a dialog window (Figure 9.9) in which further options can be selected, 
including hiding atoms and fragments, expanding the structure, deleting atoms, ENVI information, 
changing scattering factors, and adding restraints and constraints.
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Figure 9.9 — Right-click menu

Residual electron density peaks are represented as small spheres in the structure model viewer. The 
color corresponds to the height of the Q peak shown in the color scale on the right-hand side of the 
structure viewer. Clicking on the scale allows you to define a Q peak visibility threshold. This selection 
can be reverted by clicking at the bottom of the scale.

9.4.1.2 The Text Area

The text area is separated into two text fields. The top field shows the instruction/results (.res), the 
listing file (.lst), or the Checkcif report depending on which tab is activated. Below, you can find the 
Information window and the Refinement history. These two fields can also be separated by dragging 
the box to another spot on the GUI.

The text editor is showing the results file, but the plug-in will automatically create an instruction file 
when the refinement button is pressed, so it is no longer necessary to copy .res to .ins. The editor 
highlights any recognized XL command in green and makes auto-completion suggestions if XL 
commands are recognized. Hovering the mouse pointer over any command reveals syntax tool tips. 
Furthermore, AFIX and PART sections are automatically marked at the beginning of a line (Figure 
9.10).

Figure 9.10 —Text editor: AFIX and PART highlighting

The “LIST FIL:” tab is showing the list file at exactly the same line that was displayed before. Therefore, 
it is not necessary to scroll to a certain line of interest after new refinement cycles.

The “Refinement History” tab shows R1 bars for each started refinement turn. The color reflects the 
refinement results. The greener the bar, the better the R value. It is possible to revert to a previous 
instruction file by clicking on any of the bars.
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9.4.1.3 The Tool Bar

The control buttons at the top of the plug-in provide a variety of options that support you in refining your 
structure. Table 9.2 shows an overview.

Table 9.2 — Refine Structure controls

Control Function Control Function

Open structure Configure atom styles

Close structure Configure map styles

Take (POV-Ray) screen shot Toggle atoms

Hide text windows Tube model

Toggle orthographic/perspective view Run refinement

Grow/fuse Ball-and-stick model

Rename mode Toggle ADPs

Draw Q peak bonds Toggle bonds

Toggle hydrogen atoms Toggle atom labels

Undo Toggle unit cell

Redo Toggle H bonds

Cut Toggle FO map

Copy Toggle FO - FC map

Paste Deselect atoms

Find in text Create centroid

Delete all Q peaks Center selected atom(s)

Delete all hydrogen atoms Invert selection

Insert ANIS and run refinement Hide other atoms

Run CIF check Hide hydrogen atoms

Increase font size Delete selected atoms

Decrease font size Show all hidden atoms
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9.4.2 Refine the Structure

The model should be fairly complete if the AUTOSTRUCTURE plug-in or the intrinsic phasing option of 
the Solve Structure plug-in was used.

1. Inspect the model carefully, and delete extra atoms or change atom types that are not 
chemically sensible:

• You can delete an atom by right-clicking on the atom and choosing Delete 
<atom name>. Alternatively, you can select one or more atoms and click the 

Delete Selected Atoms button  .

• The best way to change the atom type is to use the renaming mode which 

can be activated by clicking the Rename mode button  . The text 
window will show the “Rename Mode” window (Figure 9.11), from which you 
can choose atom types that were assigned during structure solution from the 
“Scattering factors:” box) or any chemical element by clicking the more 
scattering factors button. You can select a label number and suffix, and then 
simply click on the atom to rename it in the structure viewer.

Figure 9.11 —“Rename Mode” window

• Each non-hydrogen atom needs to get a unique name (unless it is in a 
different residue or part). Activate the Automatically jump to first unused 
label checkbox to avoid duplicate atom names in the structure. Duplicates 
will be highlighted immediately. You can also convert residual electron density 
(“Q”) peaks into atoms by simply renaming them.



Structure Solution and Refinement APEX3 User Manual

9 - 14 DOC-M86-EXX229 V1

2. When you are finished modifying the model, click on the refinement icon  or press 
[F2] to start the least-squares refinement.

The text panel automatically reports the results, and the output files of the refinement 
(.ins, .res, .lst, .fcf) are saved to the “\work” folder. You can accept the refinement 
results by clicking the Load refinement results button or pressing the space bar (if the 
focus wasn't taken from the Load refinement results button). If the results are not 
satisfactory, you can discard the refinement results by clicking Discard results.

3. Continue modifying and refining the model until all non-hydrogen atoms are correctly 
assigned.

4. Next, click on the anisotropic refinement button  and check for any unusually large, 
small, or elongated anisotropic displacement parameters (ADPs). These could, for 
example, point to incorrectly-assigned atom types or disorder in the crystal.

5. Afterwards, missing hydrogen atoms have to be added. There are three options to 
achieve that:

• Select ShelX > Automatic HFIX. Corresponding HFIX commands for all C,N, 
and O atoms are derived from connectivity and bond length, and are 
automatically inserted into the .ins file.

• Manually add HFIX/AFIX commands to the .ins file.

• Assign Q peaks to hydrogen atoms.

6. As soon as the structure model is complete, the weighting scheme should be adjusted. 
Choose ShelX > Try To Refine Until WGHT converges (Max 10 Runs).

APEX3 automatically tries to refine the weighting scheme until convergence.

7. Finally, carefully check the listing file for warnings, indicators for extinction, or 
disagreeable reflections, and address them if required.
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9.4.3 Finish the Refinement

In order to finish the refinement:

1. Choose ShelX > Weed Unused SFAC Numbers to remove atom types from the 
scattering factor card that were not present in the structure.

2. Choose ShelX > Update UNIT Instruction.

3. Adjust the ZERR command to the correct number of formula units per unit cell.

4. Change the LIST command (if present in the .res file) in the .ins to “LIST 4”.

5. Add an ACTA command to the .ins (if not already present), and CONF if you want to 
get torsion angles calculated in the .cif file.

6. Check that the sample temperature is correct (TEMP; unit is °C) and add the crystal 
size (SIZE, unit is mm).

7. You can sort the atom list via ShelX > Sort Atoms In File. Multiple sort methods can 
be selected from ShelX > Change Sort Order....

8. Select ShelX > Try To Refine Until WGHT converges (Max 10 Runs).

9. Click the CIF Check button  to open a checkCIF report. Carefully check the 
report and address issues (i.e., repeat the above steps after the model changes).

Please note that the XL .cif file always lacks some information about the sample (e.g, 
the space group). Ignore warning messages about these entries; they will be 
addressed during report generation.

The final refinement files (.cif, .res, .ins, .lst, .fcf) can be found in the “\work” folder.
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10 Using the Generate Report Plug-in

10.1 Preparing for Report Generation

Before creating the report, make sure that your last results file (.res) has the correct values for the final 
structure:

• Correct formula (SFAC and UNIT instructions)

• Correct Z value (ZERR instruction)

• Final cell constants with ESDs (from the final *_0m.p4p file)

• Correct atom sorting and labelling

• TEMP instruction (in °C) (e.g., TEMP -173 for 100K)

• SIZE instruction

• ACTA instruction

• BOND $H instruction

• CONF instruction for torsion angles (if applicable)

• HTAB instructions for specific hydrogen bonds (if applicable)

NOTE: You may need to edit the instructions 
file to add one or more of these 
instructions or parameters. If so, 
please do another refinement cycle 
within APEX3 to generate the *.cif file.
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10.2 Starting the Plug-in

In the Task Bar’s “Report” category, click the Generate Report icon  .

The Generate Report plug-in opens, retrieves your project’s data, and populates the 
report based on the default template.

Figure 10.1 —Generate Report plug-in: initial view

10.3 Choosing a Template File

To change the formatting for your report, you can choose a template on which your report will be based. 
Template files are contained in the directory “C:\bn\src\report”.

In the right-hand section of the plug-in, use the drop-down menu to find the desired template file:

• Choose “apex2.zip” to format the report as HTML output from the plug-in, 
without instrument-specific text.

• Choose x2s.zip to format the report with SMART X2S-specific text and data.

• Choose acta.cif to format the report as a .cif file for submission to Acta 
Crystallographica.

• Use Browse... to locate another template if available.
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10.4 Creating an HTML-Formatted Report for Online or Print Distribution

To format your report as HTML, simply choose “C:\bn\src\report\apex2.zip” in the Template File: 
drop-down menu.

Bruker’s report format is an HTML file, along with necessary Java files to display the structure using the 
free structure viewer JSmol. The report may be viewed on any computer with Java and a web browser 
(Mozilla Firefox recommended). The HTML file may also be opened in Microsoft Word or other 
word-processing programs to produce printed manuscripts.

The report is shown in the “Report” tab. Additional tabs are available for specific details. It is possible to 
select specific bond lengths, bond angles, and torsion angles from the corresponding tabs by activating 
the checkboxes.

Before saving the report, add any additional information (e.g., information from your .cif file, your run 
lists, your contact information) to the report (for details, see Section 10.6).

1. In the lower right-hand corner, click the Save Report... button.

The “Save Your Report...” dialog opens.

Figure 10.2 —“Save Your Report...” dialog

2. Choose the desired directory for your report (there is no file name to type in; the final 
report will be named “report.html”, located in the chosen folder with the other required 
files).

NOTE: A “report” folder is automatically 
created in the work directory once the 
“Save Your Report...” window opens.

3. Click OK.

The report and additional files are saved to the specified directory (which takes a few 
seconds; please do not move the folder before all files are present).
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10.5 Creating a Report for Submission to Acta Crystallographica

To format your report as a .cif file for Acta Crystallographica, simply choose “C:\bn\src\report\acta.cif” in 
the Template File: drop-down menu.

Before saving the report, add any additional information (e.g., information from your .cif file, your run 
lists, your contact information) to the report (for details, see Section 10.6).

NOTE: If you need information from the .cif file 
generated by XL outside of the APEX 
Suite, you will need to import it 
regardless of whether you have 
already created an HTML-formatted 
report.

Figure 10.3 —CIF report initial view
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10.6 Adding Additional Information to the Report

To achieve a publication-quality report, you will need to add certain information to the report before 
saving it. This information may include:

• Information from a manually-edited .cif file

• The experiment’s run list (all active runs in the Run Experiment plug-in are 
automatically loaded)

• Additional information (e.g., diffractometer information, name of institution, contact 
information, etc.)

10.6.1 Adding Information from a .CIF File

To add information from a .cif file:

1. Choose Report > Import XL CIF File... from the Menu Bar.

The “Import CIF File” window opens.

2. Browse to the desired .cif file, and click Open.

The .cif file’s information is imported into the report. If information is already present in 
the imported fields, it is overwritten.

10.6.2 Adding the Run List

To add the run list:

1. Choose Report > Import Run List... from the Menu Bar.

A run list selection dialog appears (Figure 10.4).

Figure 10.4 —“Select Runs” dialog

2. Browse to your project’s location, choose the desired runs, and click OK.

The run list is imported into the report.
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10.6.3 Adding Additional Information

To add additional information to the report, simply choose the “Miscellaneous” or “Authors” tab and edit 
the information directly in the necessary fields. When you return to the “Report” tab, the new 
information will be updated in the report.

10.6.3.1 Importing and Exporting Additional Information

The “Miscellaneous” tab allows you to import and export report information (e.g., for generic information 
that is reused often, such as experiment setup and contact information).

Importing Information

To import information into the “Miscellaneous” tab:

1. Click the Import Items... button.

The “Import Items” dialog opens.

2. Browse to the .pcf file that contains the desired information.

3. Click Open.

The information is imported into the report. If information is already present in the 
imported fields, it is overwritten.
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Exporting Information

To export information from the “Miscellaneous” tab:

1. Click on the fields to select them. [Ctrl]-click to select multiple items, or [Shift]-click to 
select a range (Figure 10.5).

Figure 10.5 —Selecting data for export

2. Click the Export Selected Items... button.

The “Export Items” dialog opens.

3. Choose a directory and filename for the exported information, and click Save to save 
the information as a .pcf file.
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11 Appendices

11.1 SaintChart Output Reference

11.1.1 Run Selector (Top Right Combo Box)

This drop-down list contains entries for each run that is integrated, plus the initial passes that are made 
before each run. When the integration has finished, an additional “Integration Finished” entry is added.

Selecting an entry from this list will update the charts and graphs on the left-hand side to the 
corresponding run. If “Integration Finished” is selected, the global statistics for the whole data set will be 
displayed instead.

Entries can be selected while the integration is still in progress (it will continue running in the 
background).

11.1.2 Twin Component Selector

This list contains an entry for each domain of a twinned crystal and an additional entry for the 
combination of all domains. Selecting an entry from this list will update the charts and graphs on the left 
side to the corresponding domain(s).

Only the “All Components” entry will be available if data from a non-twinned crystal is integrated.

11.1.3 Chart Selector

This list, along the right-hand side of the screen, contains a checkbox for each chart or graph that is 
available.

A chart/graph window appears in the “Charting Area” on the left-hand side when one of the checkboxes 
is activated. Likewise, the window disappears when the checkbox is deactivated. Alternatively, a 
window can be closed by clicking the “X” symbol in the upper right-hand corner of the chart/graph 
window.

The various charts and graphs are grouped in the following categories:

• Progress Statistics: Statistics on the progress that has been made integrating the 
data and the estimated remaining time for each run and for the integration at large to 
finish.

• Per-Image Statistics: Charts/graphs in this group are updated with each image that is 
integrated.

• Periodic Statistics: Charts/graphs in this group are updated in periodic intervals when 
a local least squares refinement of the crystal and instrument parameters is performed.

• Coverage Statistics: Charts/graphs in this group contain statistics about the data set 
after the integration process has finished.
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11.1.4 Default SaintChart Items

11.1.4.1 Spot Shape Correlation

The Spot Shape Correlation graph is the best indicator for a successful integration. It plots the degree 
of correlation between the measured 3D reflection profiles and the model 3D profiles computed from 
the strong spots.

• For well-diffracting crystals with properly-chosen exposure times, the spot shape 
correlation should be in the range of 0.7 or better.

• For weak diffractors, the spot shape correlation will be lower but should be at least 0.4 
if the exposure time is chosen correctly.

• Correlation factors below 0.4 indicate a serious problem with the indexing, the 
experimental setup, or both. However, a very low spot correlation factor may occur for 
twins with a significant number of overlapping reflections—this is normal.

You can investigate any unusual features in the spot shape correlation by checking the images 
corresponding to the region of concern using the Movie Tool. To start the movie, right-click in the Image 
Display Area and choose Movie.

11.1.4.2 Average Spot Intensity and I/Sigma(I) Values

Spot intensity and I/sigma plots the average intensity and average I/sigma (intensity divided by 
standard deviation) for the integrated reflections on a given image.

11.1.4.3 Spot Shape Profiles by Detector Region

Spot shape profiles displays the model 3D reflection profiles in pixels for the nine regions of the 
detector. Holding the left mouse button down while moving the mouse enables the box to be rotated.

In general, each 3D profile should be centered in the box but the spot shapes may change from region 
to region. Multiple or deformed 3D profiles indicate that your choice of initial box size or indexing may 
be incorrect. Split spot shapes may indicate diffraction from split crystals or twins.

11.1.4.4 Average Different Between Observed and Predicted X, Y, Z

X, Y, Z error plots the average difference in pixels (X and Y) and frame number (Z) between the 
observed and predicted reflection positions on a given frame. These parameters are useful indicators of 
the plug-in’s ability to track reflections.

Errors in X, Y, and Z should be small (less than 1 pixel) and should not vary during the integration of a 
run. Large variations indicate problems with slipping crystals, misalignment of the instrument, or other 
problems.

11.1.5 Non-Default SaintChart Items

Table 11.1 — Other SaintChart display outputs

Display Description

Connected This indicator shows whether the SAINT integration engine is running in the background. 

Integration in Progress
This indicator shows whether the integration process is still in progress. This is useful, because even 
if no changes to the charts and graphs or to the log file can be seen, the integration engine may still 
be working.

Stop Integration Clicking this button will stop the integration process.

SAINT Log File Area
This is the text output from the SAINT integration engine. It contains a textual representation of the 
same information as the graphical charts, plus some additional data that is not available in the charts 
and graphs.
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11.2 Using CELL_NOW

CELL_NOW is an extremely powerful tool for determining unit cells for difficult crystals. It analyzes a list 
of reflections to find a cell and orientation matrix despite the presence of several twin domains or other 
problems.

In initial search mode, the program tries to find sets of reciprocal lattice planes that pass close to as 
many reflections as possible. The corresponding real space vectors are sorted on a figure of merit (1.0 
being a perfect fit). After the vector list has been output, CELL_NOW attempts to suggest a suitable 
cell. This will not necessarily be the conventional cell, so it should be checked using XPREP.

Once a cell is found, it may be rotated to locate further twin domains iteratively using only the 
reflections that have not yet been indexed.

If CELL_NOW fails to suggest a sensible cell, for example something may be seriously wrong with the 
reflection list (e.g., a wrong detector distance) or a cell axis is longer than the given search range.

11.2.1 Running CELL_NOW on a List of Reflections

1. Open a Command Prompt window in your “\work” directory by choosing Sample > Run 
Command....

The exported .p4p file should be available in this directory.

2. For Windows or Linux, enter the command
cell_now -t.

The terminal prints out an explanation of the program, which contains more detailed 
information about its working principles than is found in this Section’s introduction.

3. CELL_NOW requests the name of the input file and suggests a name for the output file. 
Enter the name of the input file including the file extension (for the output file, press 
[Enter] to accept the default).

4. Press [Enter] to start a general search.

Initial search (<Enter>) or specified cell search (S):

5. If the default superlattice threshold is suitable (which it normally is), press [Enter].

Superlattice threshold: an axis will be rejected if less than 
this percentage of reflections has indices not equal to 2n or 3n 
resp. [10]:

6. If the default minimum and maximum distances are acceptable, press [Enter] again.

The default range is 5 to 45 Å, which may not fit your crystal. In order to get an 
impression about the unit cell dimensions, you can use the Measure Distance tool in 
the “View Reciprocal Lattice” plug-in.

NOTE: Usually CELL_NOW is used to search 
generally for a cell, but if the cell is 
known, choose the specified cell option 
and enter the cell dimensions. 
CELL_NOW will then search for a 
matching cell.
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After some period of time, CELL_NOW presents a list of possible unit cells. This will not 
necessarily be the conventional cell, so it should be checked using XPREP (even 
possible without an .hkl file) taking the lattice type found with CELL_NOW into account.

If necessary, this conventional cell may then be used in “specified cell” search mode to 
find the orientation matrix—or the transformation matrix from XPREP can be used to 
reorient a cell (R option).

The following cells would appear to be plausible, but should be checked using  XP    
REP because they are not necessarily the conventional cells. 
 
 FOM, % with i       n  0 .2, a..gamma, volume and lattice type for potential 
unit-cells: 
      1     1 .000    85.3   12.692  11.016  14.648   89.70   90.95   90.00    
2047.7  P 
------------------------------------------------------------------------------ 
 Cell for domain  1:   12.692   11.016   14.648    89.70    90.95    90.00 
 Figure of merit: 0.619   %(0.1):  68.3   %(0.2):  85.3   %(0.3):  91.0

CELL_NOW has identified a domain that fits 85.3% of the data with a tolerance of 0.2 
(deviation from integer HKL indices).

7. Enter the maximum deviation from integer index cutoff (the default of 0.25 is 
somewhat high; normally use 0.1 or 0.15). Press [Enter].

New cell from list (number), reorientate (R), accept (A) or quit (Q) [A]: A

8. Enter A or just press [Enter] to accept this cell. The program asks for a name for a .p4p 
file. Enter the name of the .p4p file for this solution (in this example, domain1.p4p).

.p4p or .spin file to write domain to:domain1.p4p

RLATT color-coding employed in file: domain1.p4p 
 White: indexed for first domain 
 Red: not yet indexed 
 
   877 reflections within 0.250 of an integer index assigned to domain  1, 
   877 of them exclusively;   122 reflections not yet assigned to a domain
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9. 122 reflections, approximately 1/10 of the data, have not yet been indexed (assigned to 
a domain). This is more than might be expected for random noise peaks. A search for 
an additional domain makes sense. The domain 1 cell will be rotated to locate further 
twin domains iteratively using only the reflections that have not yet been indexed. Enter 
S to search for another orientation of the newly chosen cell.

Re-refine initial cell (R), search for next domain (S), quit (Q) or choose new 
cell from list (enter number) [S]:S

Cell for domain  2:   12.692   11.016   14.648    89.70    90.95    90.00 
 
 Figure of merit: 0.643   %(0.1):  69.7   %(0.2):  97.5   %(0.3):  98.4 
 
 Orientation matrix:  0.00598966  0.00402327  0.06807401 
                     -0.03367313 -0.08180340  0.00480114 
                      0.07099302 -0.03914713 -0.00221035 
 
 Rotated from first domain by 179.7 degrees about 
 reciprocal axis  1.000  0.001 -0.032  and real axis  1.000  0.002 -0.010 
 
 Twin law to convert hkl from first to      0.999   0.004  -0.019 
 this domain (SHELXL TWIN matrix):          0.003  -1.000  -0.004 
                                           -0.064   0.006  -0.999

CELL_NOW has identified an additional domain that fits 97.5% of the remaining data 
with a tolerance of 0.2. The relationship between this domain and the first domain and 
the SHELXL TWIN matrix are reported. This example is for a rotational twin about the 
a* axis.

10. Enter the maximum deviation from integer index cutoff for the second domain.

11. Enter the name of the .p4p file for this solution (in this example “domain2.p4p”).

.p4p or .spin file to write domain to:domain2.p4p

 
RLATT color-coding employed in file: domain2.p4p 
 White: indexed for first domain 
 Green: current domain (but not in a previous domain) 
 Red: not yet indexed 
 
   691 reflections within 0.250 of an integer index assigned to domain  2, 
   119 of them exclusively;     3 reflections not yet assigned to a domain 
 
 Re-refine initial cell (R), search for next domain (S), quit (Q) or choose 
 new cell from list (enter number) [Q]

12. Check the number of indexed reflections, and how many reflections belong exclusively 
to the second orientation.

If the program does not find a suitable twin rotation, it will find a solution that indexes 
the first domain again. The rotation angle is then close to 0°, and almost no reflections 
belong exclusively to the second domain.

13. Enter <q> to exit CELL_NOW, only 3 reflections are not indexed (and therefore it 
makes no sense to search for further twin orientations).

C:\struc\guest\twin>

NOTE: At this point CELL_NOW has indexed a 
two-component twin. The orientation 
matrices for the two components are in 
the “domain2.p4p” file.
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11.3 Configuring the Suite

The Bruker Suite includes the ability to customize many features of the program. Most customizations 
should be left to the site administrator, but some introduction is appropriate.

The following is a collection of examples of possible changes to the configuration files that control the 
look and feel of the GUI.

11.3.1 The bn-config Configuration File

The appearance and behavior of this Suite of programs can be modified by a configuration file. The 
programs read a series of configuration files in following order. As described below, a specification in a 
later file overwrites a setting in an earlier file.

For Windows: these files are (in order):

1. bn-config.py in the system drive folder (C:\)

2. bn-config.py in the “USERPROFILE” folder

3. bn-config in the current folder

For Linux/UNIX: these files are (in order):

1. /usr/local/lib/bn-config.py

2. .bn-config in your home directory (Please note the initial “.” character, which renders 
this file invisible for the normal ls command).

3. bn-config in your current directory.

If none of these files are present (e.g., when the program has just been installed), all parameters use 
built-in defaults. To change a single configuration parameter, create or edit one of the three files and put 
in a value for the parameter to be customized. You should:

• put a parameter in (1) if it should be the system default for all users;

• put it in (2) if it is your own default, and other people might want to use other values; 
and

• put it in (3) if it is only required for a single project.

The configuration files are read as Python programs, and therefore syntax is very important. The best 
way to use it is to only use variable assignments or function calls. If required, you can comment out 
lines from your configuration file by preceding them with a # character.

NOTE: Leading space is significant. Start all 
assignments in the first column. 
Variable names are case sensitive.

NOTE: APEX3 needs to be restarted before 
the changes are applied. Some 
parameters are stored within the 
project, therefore only new projects will 
have the changed defaults.
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11.3.2 Configuration File Examples

11.3.2.1 Comments

A few notes about Python comments:

Three quotation marks in a row on a line (“““) start a comment section The next three quotation marks 
(“““) end the section.

The “pound” or “number sign” character (#)starts a simple comment. This can be anywhere on a line.

11.3.2.2 Default Color Scheme for Image Display

The default color scheme for the image display is given in:

colorramp='Colored_SCD.ICM'

This is the typical BAXS orange display.

The most frequently used other color choices are:

Black_On_White_SCD.ICM

White_On_Black_SCD.ICM

The_Blues_ANY.ICM

Other color ramps are in:

• Windows: C:\bn\src\gui\intensitycolormaps

• Linux:  /usr/local/bn/src/gui/intensitycolormaps

11.3.2.3 User Positions

Up to four user positions can be activated in the Center Crystal and Screen Crystal plug-ins.

The detector distance is specified in millimeters.  The goniometer angles are specified in degrees.  To 
activate a user defined goniometer position, its userpos<#> variable and at least one of the positional 
variables must be uncommented. For instruments with a manual detector track, the detector distance 
variable (dx) should normally not be uncommented because of the risk of setting the distance to a 
different value than the actual distance. The chi angle setting must be uncommented for instruments 
with a Kappa goniostat.

An example user position:

userpos1 = "User Position 1" 
userpos1_dx = 40.0 
userpos1_2theta = 23.0 
userpos1_omega = 23.0 
userpos1_phi = 90.0 
userpos1_chi = 54.74

11.3.2.4 Automatically Connect to BIS

Automatically connect to the instrument when needed:

autoconnect = True

NOTE: This is a protected variable that is 
controlled by the System Administrator.
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11.3.2.5 Frames in a Network Shared Folder

IP address or DNS name of the file server used for storing images, followed by the name of a network 
shared folder on that server. Add additional path segments as comma-separated and quoted strings:

fileserver=('x8-client','frames')

To find out the DNS, enter the following at a command prompt:

• Windows: echo %computername%

• Linux: hostname

11.3.2.6 Supported Filename Protocols

Currently-supported filename protocols are smb for files that are accessed over a Microsoft Windows 
network, and file for local files:

universalfnprotocols=('smb','file')

11.3.3 Functionality Groups in the Configuration File

Sometimes a complete group of options need to be changed to get a specific functionality. For these 
cases, there are function calls that change a number of variables at once.

Due to the “default-like” nature of these function calls, they should probably be used only in the 
site-wide configuration files, and even there only at the beginning (but this is not enforced).

The available functions are:

• default_protein()

This switches from the default “small-molecule” parameters to more protein-like 
parameters. At this time, the following parameters are set:

chiralonly=1 
autochiralpointgroup=1 
resomode=1 
resolution=2.5

• default_noprotein()

This sets the defaults back to small-molecule values.
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